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ne of the “inflexion points” of 
the development of the Web, 
when commentators and 

analysts draw breath for long enough to 
chronicle its history, is certain to be the 
day that Google, through first Gmail and 
then Google Maps, opened the eyes of 
millions to the fact that the Web can be 
smarter, more responsive, and interac-
tive…above all, that it doesn’t have to 
involve “click, wait, and refresh.”
	 Google happened to use AJAX 
(Asynchronous JavaScript + XML) for 
those two bellwether apps. But those of 
us who have followed the Macromedia, 
now Adobe, story know of course that 
AJAX is very much a Johnny-come-lately 
to the Rich Internet Applications party. 
	 Whereas “AJAX” is barely a year old 
(Jesse James Garrett having coined it Feb 
18, 2005), “Rich Internet Applications” as a 
term was in circulation many years before. 
Already at the beginning of the new cen-
tury, Macromedia’s developer-innovators 
were using the term, so that by 2003 for 
example “Flash-enabled RIAs” was really 
quite a common term in developer mail-
ing lists and Macromedia user groups. 
	 Macromedia anticipated AJAX in 
every way, pioneering the RIA approach 
of which AJAX is merely a subset, and in 
2006 its prescient approach is productized 
in Flash and Flex and FlexBuilder and Flash 
Player, products which over time Adobe 
is likely to help turn into the best-known 
suite of software on the planet.
	 From a personal perspective I shall 
never forget a session that Christophe 
Coenraets gave at one of the SYS-CON 
Events conferences I was fortunate 
enough to Chair, namely Web Services 
Edge Conference & Expo (East) 2004, in 
Boston. The session was called “Code-
Based Rich Internet Applications with 
Macromedia Flex” and covered using 
components, layouts, and managers to 
build user interfaces as well as using Flex’s 
XML-based language, MXML, to create 
and manipulate client-side data models. 

What I remember above all was that the 
delegates in the completely packed room 
were spellbound, literally spellbound, 
by Christophe’s agile demonstration of 
how much could be done with the Web 
vs. how little anyone was (then) doing. It 
was as if we’d lost our collective critical 
judgement, his presentation seemed to 
imply—as users, and therefore as devel-
opers, we’d begun to accept latency that 
ought never to have been tolerated, and 
had almost been self-brainwashed into 
thinking of the Web as “pages” when that 
in many circumstance was far from the 
best metaphor. For many in the room, it 
was an epiphany, you could sense it.
	 So in reality the inflexion point came 
long before AJAX, and even longer before 
Gmail and Google Maps. And it came from 
Macromedia as much as anyone.
	 SYS-CON Events—a wholly owned 
subsidiary of SYS-CON Media which 
brings you MXDJ each month—has been 
working with Adobe behind the scenes 
just recently to bring you the RIA story 
in a major educational event so that you 
don’t fall into the trap of failing to see the 
wood for the trees. After all, Flash also 
interacts with JavaScript on a web page, 
and it’s a highly suitable, lightweight tool 
for highly responsive web apps. Google 
Maps could just as easily have been done 
in Flash several years before it was done in 
AJAX. Why it wasn’t, who knows? Perhaps 
this will be one of the enigmas discussed 
at our upcoming Rich Internet Apps 
Conference in August 2006 (http://www.
RIAConference.com).
	 So, will Adobe try and crush AJAX, 
Microsoft-style? And/or openLaszlo? 
Most definitely not. Under Kevin Lynch’s 
technologically nuanced and developer-
centric leadership, it seems much more 
likely that Adobe’s Platform Business Unit 
will concentrate on inspiring developers 
to use Flash and HTML “with an AJAX 
approach” to build Web 2.0-style applica-
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orums (message boards) are a 
great way to share ideas, debate 
on current issues, or offer technical 
assistance to your clients. A forum 

can really help you build up a community 
around your website, increase traffic, 
and improve communication with your 
clients. Although you can find a wealth 
of free forum applications out there, 
which you can install and customize for 
your needs, this article teaches you how 
to build your own forum from scratch to 
make it fit your specific requirements. 
(You can view this article in its original 
www.macromedia.com/devnet.)
	 We will walk you from designing and 
setting up your database to building a 
basic front end, adding user authentica-
tion, allowing subscription to message 
threads, and sending topic reply notifica-
tions by e-mail. You can have a fully func-
tional forum in no time, with minimum 
effort and coding.

Planning the Forum
	 In this tutorial, you will use 
Dreamweaver 8 and ImpAKT to build a 
forum application which will allow users 
to:
•	 View a list of discussion topics
•	 Read the messages associated to each 

topic
•	 Register an account with the forum, 

and upload a profile photo
•	 Login and logout
•	 Post a new message in any topic
•	 Reply to other messages
•	 Subscribe to a discussion thread (a 

chain of messages that are replies to 
an initial message)

•	 Receive e-mail notifications when a 
new message is posted in a thread 

they have subscribed to
	 Before you start building the forum, 
please make sure that:
•	 You have a running database server 

and web server with PHP language 
support

•	 You have installed the required soft-
ware: Dreamweaver and ImpAKT

•	 You have correctly defined a 
Dreamweaver site with a PHP_MySQL 
testing server

•	 You have set up the database provided 
with this tutorial and have created a 
connection to it

Setting Up the Development 
Framework
	 First you have to set up your appli-
cation server environment and install 
Dreamweaver 8 and ImpAKT.
	 This article assumes that you have 
already installed and configured a web 
server with PHP and MySQL support. If 
this is not the case, take a look at the 
following articles from the Developer 
Center:
•	 Setting Up Your PHP Server 

Environment Using Linux, Apache, 
MySQL and PHP (by David Sklar) if you 
use the LAMP platform

•	 Setting Up the PHP, MySQL, and 
Apache Server Platform on Macintosh 
OS X for Dreamweaver MX (by Minh 
Huynh) if you’re working in Mac OS

•	 Setting up PHP for Microsoft IIS (by 
Andrew Stopford) if you’re a fan of IIS

	 If you’re using Windows, also take 
a look at WAMP Server, a free tool that 
automatically installs Apache, PHP 
5, MySQL server, phpMyAdmin, and 
SQLiteManager. For detailed instructions 

on installing WAMP Server, see this tech-
nical note on the InterAKT site.
	 Before you install ImpAKT, you need 
to have installed Dreamweaver 8. You 
can install and manage the extensions 
using Extension Manager, an accessory to 
Dreamweaver.

What Is ImpAKT?
	 ImpAKT is a Dreamweaver exten-
sion that offers a collection of wizards 
and server behaviors that will help 
you set up a dynamic website from 
scratch, with no coding at all. ImpAKT 
automates most common programming 
tasks and patterns, and even helps 
inexperienced HTML designers perform 
complex tasks. For example, ImpAKT 
will help you set up your site for user 
authentication, validate your visitors’ 
input, send e-mails after forms have 
been submitted, and upload files and 
images.
	 Extensions are software tools that 
enhance the standard functionality of 
Dreamweaver, much like plug-ins or 
add-ons. They can vary from simple code 
snippets to complex applications. Their 
purpose also varies: they can reduce 
manual coding, minimize repetitive tasks, 
fix certain bugs or errors, increase pro-
ductivity, or build a specific object.
	 Extensions are usually delivered as 
executable MXP files. When you run 
them, the Extension Manager initiates the 
installation.
	 Start the installation by download-
ing the extension using the links at the 
beginning of this article. Then double-
click the MXP file. After the ImpAKT 
installation is initiated, you’ll see a dis-
claimer. If you agree to the terms, click 
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Accept to continue the installation. When 
the Extension Manager finishes installing 
(usually just a few seconds), you’ll see a 
dialog box notifying you that the installa-
tion is complete.
	 You’ll notice that ImpAKT is listed in 
the Extension Manager window.
	 If Dreamweaver is open, close it and 
then relaunch it so the changes caused 
by ImpAKT can take effect. Each installed 
extension modifies the Dreamweaver 
standard workspace by adding its own 
commands, buttons, or menus. The 
ImpAKT elements are added to the Insert 
bar and to the Server Behaviors menu (in 
the Application panel).
	 Notice that a new tab called MX 
Kollection appears in the Insert bar.
	 ImpAKT is part of a bundle of 
Dreamweaver extensions, which is why 
the tab is called MX Kollection. For more 
information, visit the MX Kollection home 
page.
	 From the MX Kollection tab, you can 
access some of the most common wiz-
ards and commands in ImpAKT that help 
you build database-driven web forms 
for inserting, updating, and deleting 
information, and set up professional user 
authentication for your website.
	 The second area where you can 
access ImpAKT commands is the Server 
Behaviors tab of the Application panel.
	 In the next section, you will define 
your site in Dreamweaver.
	 Before you build the forum, you 
need to set up your site in Dreamweaver. 
For a quick site setup, take a look at 
this TechNote: How to Define a Site in 
Dreamweaver. A minimal setup requires 
you to configure at least these sections:
•	 Local Info, which identifies the site files 

in Dreamweaver and enables the site 
management features

•	 Remote Info, which defines the set-
tings to access the remote web server 
where your site will be uploaded

•	 Testing Sever, which defines a private 
place to act like a public server to test 
the application and connections to the 
database

	 Follow the instructions in this 
TechNote and make sure you set the 
server model to PHP MySQL in the Testing 
Server section.
	 Download the tutorial sample files 
and unzip them to your site’s root folder. 

	 In the next section, you will set up 
and connect to your database.

Setting Up Your Database
	 The forum is completely dynamic. It 
stores and extracts all information from 
a database. A typical forum is basically a 
collection of messages posted by users 
and organized by topics. Therefore you 
need at least these three tables for your 
forum database:
•	 one for user information: user_usr
•	 one for messages: message_msp
•	 one for topics: topic_top

	 The SQL code that creates the topic_
top table is pretty straightforward. Notice 
that the topic title is defined as a unique 
key, meaning there shouldn’t be any top-
ics with the same title:

CREATE TABLE topic_top (

  id_top int(11) NOT NULL auto_incre-

ment,

  title_top varchar(100) NOT NULL 

default ‘’,

  description_top varchar(200) default 

NULL,

  PRIMARY KEY  (id_top),

  UNIQUE KEY title_top (title_top)

); 

          

	 Here is the code that creates the mes-
sage_msg table:

CREATE TABLE message_msg (

  id_msg int(11) NOT NULL auto_incre-

ment,

  idtop_msg int(11) NOT NULL default 

‘0’,

  idmsg_msg int(11) default NULL,
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  id_init_msg int(11) NOT NULL default 

‘0’,

  idusr_msg int(11) NOT NULL default 

‘0’,

  date_msg datetime NOT NULL default 

‘0000-00-00 00:00:00’,

  subject_msg varchar(100) default 

NULL,

  content_msg text NOT NULL,

  subscribe_msg tinyint(4) NOT NULL 

default ‘0’,

  PRIMARY KEY  (id_msg)

);

          
	 The following snippet shows the SQL 
code for setting up the table:

CREATE TABLE user_usr (

  id_usr int(11) NOT NULL auto_incre-

ment,

  name_usr varchar(100) NOT NULL 

default ‘’,

  email_usr varchar(150) NOT NULL 

default ‘’,

  password_usr varchar(100) NOT NULL 

default ‘’,

  active_usr tinyint(2) NOT NULL 

default ‘0’,

  randomkey_usr varchar(100) NOT NULL 

default ‘’,

  PRIMARY KEY  (id_usr),

  UNIQUE KEY name_usr (name_usr)

);

          
	 Notice that because the user name 
must be unique, it was defined as a 
unique key.
	 If you are unfamiliar with database 
terminology (primary keys, foreign keys, 
self foreign keys, and the like) and data-
base architecture techniques, check out 
the Database Concepts article on the 
InterAKT site.
	 Now that you have an idea of how 
your database will look, fire up the 
sample SQL script in your MySQL con-
sole or in your favorite database man-
agement software (such as phpMyAd-
min) and create the forum database. 
Include the following line at the begin-
ning if you want to create a separate 
database:
create database mm_forum;
	 The sample SQL script also contains 
some dummy data, which you will use 
when building the forum front end. Now 
you’re ready to connect to your newly 
created database.

Connecting to the Database
	 To connect to the database in 
Dreamweaver, follow these steps:
•	 Start Dreamweaver.
•	 Open the index.php page from the 

forum site.
•	 Choose Application panel > Databases 

tab, click Plus (+), and select MySQL 
Connection.

•	 Configure your connection to your 
newly created database.

	 If you are not sure how to connect 
to the database server, ask your system 
administrator for the proper access infor-
mation. Click the Select button to locate 
the forum database. You can test the con-
nection using the Test button.
	 In the next section you will learn how 
to build the forum home page, which dis-
plays a list of topic titles and descriptions.

Displaying the Forum Topics
	 The forum home page displays all 
topic titles and descriptions. Beside these 
values, which are extracted from the 
database, you will have to display links to 
enable users to set up an account or log 
in.
	 All the information will be displayed 
in the index.php page. The page layout is 
already designed with CSS, and has areas 
(<div> containers) for displaying various 
information from the database.
	 To see the <div> containers better, 
activate the CSS Layout Backgrounds and 
CSS Layout Outlines options by choosing 
View > Visual Aids and then selecting the 
option in the submenu.
	 Notice that the <div> tags now 
appear more visible. The CSS Layout 
Backgrounds option adds a different 

color to every <div> tag to make them 
easier to distinguish from one another.
	 Turning on the CSS Layout 
Backgrounds option does not display the 
real color of the <div> containers but 
it can help you sort out which element 
belongs into which container.
	 Note: CSS stands for Cascading Style 
Sheets—a standard that enables you 
to separate content from presentation. 
You can create styles that define the font 
characteristics, colors, and even position-
ing of your content. You can then apply 
these styles to the desired elements. 
The CSS styles are already defined in the 
forum.css style sheet that comes with the 
tutorial sample files.
	 The topic is a link to the page dis-
playing the corresponding messages. To 
create the topic list, you have to do the 
following:
•	 Open the index.php page in 

Dreamweaver.
•	 Create the recordset that retrieves 

topic information, the ID, title, and 
description.

•	 Display the recordset contents on the 
page.

	 To create the recordset that retrieves 
the forum topics, follow these steps:
•	 Click the Plus (+) button on the 

Bindings tab in the Application 
panel. From the pop-up menu select 
Recordset (Query).

Configure the recordset dialog box 
options:
•	 For the recordset name enter rsTopics.
•	 In the Connection pop-up menu, select 

connForum.
•	 Select the topic_top table in the Table 
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pop-up menu.
•	 To sort the topics alphabetically, select 

the title_top column in the Sort pop-
up menu; for the method (the next 
pop-up menu), select Ascending.

•	 Click OK to close the dialog box and 
add the recordset The recordset 
appears in the Bindings tab.

•	 After having created the recordset, you 
must use its fields to build the home 
page:

•	 With the index.php page open, expand 
the rsTopics recordset in the Bindings 
tab.

•	 Clear all content from the second 
<div> container (the white one).

•	 Drag and drop the title_top field on 
the Bindings tab in the second <div> 
container.

•	 Place the cursor after the added topic 
title and press Enter (Return) to create 
a new paragraph.

•	 To distinguish the topic title from its 
description better, format it as Heading 
3 by selecting the dynamic text and 
then choosing Heading 3 from the 
Format pop-up menu in the Property 
inspector.

•	 The topic title must be linked to the 
messages page. This page displays all 
messages from the selected topic. The 
messages are filtered by the topic ID, 
which is passed from the home page 
as a URL parameter. With the topic title 
selected, click the Folder icon in the 
Property inspector to define the link.

•	 In the dialog box that opens, select the 
view_message.php page, and then click 
the Parameters button to define the URL 
variable that will filter the messages:

•	 In the Parameters dialog box, click 
the Plus (+) button to add a new URL 
parameter.

•	 In the Name field enter id_top.
•	 For the Value, click the Dynamic Data 

icon (the yellow lightning bolt), and 
then select the id_top field of the 
rsTopics recordset.

•	 Click OK to define the parameter value.
•	 Click OK twice to create the link.
•	 Drag and drop the description_top 

recordset field in the Bindings tab in 
the paragraph below the link.

	 At this point, if you try to preview 
your page in the browser, you’ll notice 
that only the first topic is displayed. You 
need to loop through all records in order 

to display all the topics:
•	 Select the topic title and description 

and apply a Repeated Region server 
behavior. You can access it from the 
Application tab of the Insert bar.

•	 Note: Make sure you select just the 
dynamic text, not the <div> container.

•	 In the Repeat Region dialog box, 
configure the repeat region to use the 
rsTopics recordset and click All Records 
to display all records.

•	 Click the OK button to close the dialog 
box and apply the server behavior. 
You’ll notice that a gray border labeled 
Repeat is displayed around the topic 
information.

•	 Save the page and upload it to the 
testing server. Press F12 (Windows) or 
Option+F12 (Macintosh) to load the 
page in your web browser.

•	 http://www.macromedia.com/devnet/
dreamweaver/articles/forum_pt1/
fig24_lg.html

	 In the next section, you’ll change the 
way links look using CSS styles.
	 In this section you will use the uni-
fied CSS panel in Dreamweaver 8 to style 
the links in your forum. (Julie Hallstrom 
takes you through all the new CSS fea-
tures in Dreamweaver 8 in her article, An 
Overview of CSS in Dreamweaver 8.)
Here you will make the forum links 
orange and then apply a mouseover 
effect, so that they become underlined 
when users hover their mouse cursors 
over them:
•	 With the index.php page open in 

Dreamweaver, select the dynamic text 
that displays the topic title. Then, in 
the tag selector, click the <a> tag.

•	 The CSS panel displays the existing 
styles. If you cannot see the CSS panel, 
select Window > CSS Styles.

•	 Notice that the a:link and a:visited 
styles are already defined for you, but 
they have no properties. To define a 
new property, click the Add Property 
link.

•	 Select Text-Decoration from the first 
pop-up menu and None from the 

second one. This removes the default 
underlining of links.

•	 Now make the links orange. Click the 
Add Property text to define a new rule. 
From the properties pop-up menu, 
select the Color option.

•	 Select the color by clicking the button 
displayed in the value field. Pick an 
orange shade from the color picker.

•	 Add a mouse-over effect for links. To 
do that, you need to define a new CSS 
rule by clicking the corresponding but-
ton from the CSS panel.

•	 In the displayed dialog box, select the 
Advanced option button and then 
choose the a:hover selector and make 
sure you define it in the forum.css style 
sheet.

•	 Click OK to create the rule. A new dia-
log box is displayed, where you can 
define the CSS properties for the new 
rule. The only property you need, for 
now, is to make the text underlined. 
Click the Underline option in the 
Decoration section and then click OK.

	 Notice how easy it is to edit the exist-
ing properties, add new properties, or 
define a new CSS rule from scratch in 
Dreamweaver 8—you can do it all from 
one panel. The topic title links have now 
changed their color.
	 Notice that the CSS file attached to 
the page is opened. Save the CSS file and 
the page and upload both of them to the 
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server. Preview the forum home page in 
the browser to see the changes.
	 In the next section, you will learn how 
to display messages in a particular topic.
	 The topic messages will be displayed 
in the view_message.php page. The page 
layout is already created using <div> 
tags. You can change the existing styles 
and layout on the CSS panel.
The page displays the following for each 
message:
•	 User name and avatar (profile photo) in 

the left section
•	 Message subject, body, and date of 

posting in the center <div> tags
•	 Link to reply to the message

	 To create the message list, do the fol-
lowing:
•	 Create an advanced recordset that 

retrieves information from two tables 
and filters it by the topic ID received as 
a URL parameter.

•	 Display the user name and a thumbnail 
of the profile photo.

•	 Display the message details.
•	 Use conditional regions to control the 

output.

	 First, you must create the advanced 
recordset. This recordset will have to per-
form a join between the message_msg 
and user_usr tables.

Note: The SQL join is an operation that 
enables you to retrieve information from 
two or more tables that are related through 
a foreign key. You can learn more about 
joins by reading the Relations Between 
Tables tutorial on the InterAKT site.

	 To create the recordset, follow these 
steps:
•	 In the Bindings tab, click the Plus (+) 

button. Select Recordset (Query) from 
the pop-up menu.

•	 In the simple recordset configuration 
dialog box, enter rsMessages as the 
recordset name.

•	 From the Connection pop-up menu, 
select the connForum database con-
nection.

•	 In the Table pop-up menu, select the 
message_msg table.

•	 To retrieve messages in a particular 
topic, you must add a filter condition. 
In the Filter pop-up menu, select the 
foreign key to the topic table: idtop_

msg. For the value to match, select URL 
Parameter from the pop-up menu. For 
the parameter name, enter id_top (the 
name specified when you created the 
topic link).

•	 Define the join between the message_
msg and user_usr tables. Because you 
cannot define it in the simple recordset 
window, click the Advanced button in 
the Recordset dialog box.

•	 Enter the SQL code in the SQL text 
area. When switching from the simple 
dialog box to the advanced one, your 
settings will be preserved in the SQL 
code.

•	 You have to change this code in order 
to perform the join. Place the cursor 
after the message_msg table name 
and enter the following code:

•	 LEFT JOIN user_usr ON idusr_msg = 
id_usr

•	 This is all it takes to create the query.
•	 Review the completed dialog box and 

click OK to close it.

	 The recordset is displayed in the 
Bindings tab. It contains fields from both 
tables. After having retrieved all neces-
sary information from the database, it is 
time to put it to use and display it in the 
page.

Displaying Profile Photos
	 Here is how you want to display the 
user information: user name followed by 
a thumbnail of the user’s photo. Place 
your cursor in the left <div> container 
and remove the placeholder text User 
information. Drag the name_usr field 
from the Bindings tab and drop it where 
the deleted text was.
	 Now make some room for the image. 
Place the cursor after the dynamic text 
you’ve entered and press Shift+Enter. This 
inserts a line break after the user name.
To display a thumbnail of the user’s 
photo, you will use an ImpAKT server 
behavior called Show Thumbnail. This 
server behavior generates thumbnails of 
the selected images from your server.
Select the Server Behaviors tab > Plus (+) 
> MX Kollection > File Upload, and then 
select Show Thumbnail.
Configure the user interface as follows:
•	 In the File folder text box, enter the 

path to where the user photos are 
stored. Click Browse and select the 
Profiles folder.
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Note: Make sure your database is populated 
with the sample data from the mm_forum.
sql script and that the Profiles folder is 
inside your site root and contains the sam-
ple images that come with this tutorial.

•	 In the Recordset pop-up menu, select the 
rsMessages recordset you created earlier.

•	 In the Field pop-up menu, select the 
photo_usr recordset field that stores 
the photo names.

•	 In the Resize method pop-up menu, 
select Proportional - Fit to box. This 
way, the aspect ratio of the photos is 
preserved, while guaranteeing that 
images fit the specified space.

•	 For the box size, enter 80 for the Width 
and 80 for the Height, (these dimen-
sions are specified in pixels).

•	 Click OK to apply the server behavior. 
An image placeholder is displayed in 
the Design view. You cannot see the 
actual photos, however, because they 
are retrieved dynamically from the 
database.

•	 Note: After you apply any of the 
ImpAKT server behaviors or wizards, a 
new folder will be created in your site 
root, called includes. This folder stores 
the files required for the server behav-
iors and wizards to work. You must 
upload the entire folder to your remote 
or testing server before previewing any 
pages in the browser.

	 Next, display the actual message 
information:

•	 Select and delete the message subject 
placeholder text. Drag and drop the 
subject_msg field from the Bindings 
tab in its place.

•	 Repeat the same procedure to replace 
the message body text with the con-
tent_msg recordset field.

•	 The last row displays the date and time 
when the message was posted to the 
forum. Remove the existing text and 
type Posted on (make sure to leave a 
trailing space so that the date will not 
appear right next to the text). From 
the Bindings tab, drag and drop the 
date_msg field after the entered text.

•	 At this point, all the necessary infor-
mation is displayed on the page, but 
for one message only. To display all 
records, you must use a Repeated 
Region server behavior, just as you 
did for the topics list. From the tag 
selector, click the <div.content> tag to 
select it.

•	 Doing this selects the content within 
the white <div> tag.

•	 Go to the Application tab of the Insert 
bar and click the Repeated Region 
icon. Configure the dialog box that 
opens to use the rsMessages recordset 
and to show all records.

	 To test the page, save it and upload 
it to the testing server. Do not forget to 
upload the includes folder as well. Load 
the forum home page in the browser and 
click a topic title. If you use the sample 
data from the SQL script that came 
with this tutorial, select the topic called 
“Investment Opportunities”—this is the 
only topic that contains some sample 
messages.
	 In the next section, you will learn how 
to show or hide content using conditional 
regions.

Controlling Output with 
Conditional Regions
	 What happens if you click a topic that 
contains no messages?
	 To avoid having users see this type 
of page, you can use conditional regions 
to control what content is displayed 
and when. Dreamweaver 8 comes with 
a predefined set of conditional regions 
that help you hide or display content only 
when a condition is met—if a recordset 
is empty, if it is the first record in the 
recordset, and so on. In addition to this 

set, ImpAKT offers a set of conditional 
regions—if a user is logged in, if a file 
exists or a field has changed.
	 The message list elements must be 
displayed only when messages exist for 
the selected topic. To enforce this behav-
ior, you will use the Show If Recordset Is 
Not Empty server behavior:
•	 Select the <div.content> tag from the 

tag selector.
•	 Apply the Show If Recordset Is Not 

Empty server behavior from the 
Server Behaviors tab > Plus (+) > Show 
Region.

•	 In the Show If Recordset Is Not Empty 
dialog box, configure the user interface 
to use the rsMessages recordset.

•	 Click OK to apply the server behavior. A 
gray border labeled “Show If...” appears 
around the message details.

•	 Now if a topic without messages is select-
ed, the page will no longer look broken.

•	 Add a message that tells users the 
topic is empty. To do that, place the 
cursor inside the content <div> tag, 
on the very last blank space. Press 
Shift+Enter to create a new line and 
type the following text: There are no 
messages in this topic yet.

•	 Select the text you just entered 
and apply the Show If Recordset Is 
Empty conditional region (from the 
Application tab in the Insert bar).

•	 In the displayed dialog box, select the 
rsMessages recordset, as you did for 
the previous conditional region.

•	 Click OK to apply the conditional 
region.

•	 Now if you access a topic that has no 
messages, the text you entered above 
is displayed.

	 Finally, think of the following 
situation: Not all users might want to 
include a photo next to their name. 
If you display the messages from the 
Investment Opportunities topic, you’ll 
notice that Angel has not uploaded a 
profile photo.
	 In this case, a default image is dis-
played. To display no image at all, you 
have to apply another conditional region:
•	 In Design view, select the image place-

holder.
•	 Select the Server Behaviors tab from 

the Application panel and click Plus 
(+) > MX Kollection > Conditional 
Regions > Show If File Exists. This will 
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hide the default image (“Image not 
found”) for users who haven’t upload-
ed an avatar.

•	 Configure the conditional region dia-
log box as follows:

•	 Select the folder that stores profile 
photos: profiles/

•	 Select the recordset that displays the 
message information: rsMessages

•	 In the Field pop-up menu, select the 
field that stores the filename: photo_
usr

•	 Click OK when done.
•	 Save your page, upload it to the testing 

server, and preview it in the browser.

	 Congratulations! The pages for dis-
playing forum topics and messages are 
now completed.

Where to Go from Here
	 In this tutorial, you have learned how 
to connect to a database, pull data from 
your tables, and style it with CSS using 
Dreamweaver 8 and ImpAKT.
	 In Part 2 you will learn how to use 
the ImpAKT wizards and server behav-
iors to implement a user authentica-
tion system, create forms to post new 
messages or reply to existing ones, 
and notify subscribers of replies by e-
mail.

Setting Up User 
Authentication
	 In the following sections of this tuto-
rial, you will use ImpAKT to build a user 
authentication system for your forum. 
You need authentication to prevent 

pranksters from posting a load of gar-
bage to your forum and getting away 
with it. If users want to post messages to 
the forum, they must register an account, 
activate it, and then log in. Only then 
will they be able to post messages to the 
forum.
	 To build the user authentication sys-
tem, you will do the following:
•	 Configure user login settings from the 

InterAKT Control Panel.
•	 Create a user registration page.
•	 Create the user login page.
•	 Create a logout link.
•	 Use conditional regions to control 

which content is public and which is 
private.

Configuring Login Settings
	 The InterAKT Control Panel comes 
with your ImpAKT installation and is a 
central place for all configuration options 
for your site. The InterAKT Control Panel 
can be accessed from the MX Kollection 
tab of the Insert bar.
	 Alternatively, you can access the 
InterAKT Control Panel by clicking the 
Server Behaviors tab > MX Kollection sub-
menu.
	 The InterAKT Control Panel offers a 
quick and convenient way to configure 
the most common settings for your 
development environment and for your 
site. Once configured, the settings will 
be remembered, thus saving you a lot of 
time.
	 Here are just a few of the settings you 
can configure with the InterAKT Control 
Panel:

•	 Date formats: Change the date and 
time formats for the pages built with 
ImpAKT to match your specific regional 
settings (American, German, and so 
on).

•	 Language settings: Change the lan-
guage for form buttons, error mes-
sages, labels, and hints generated by 
ImpAKT. You can choose one of the 
predefined 11 languages.

•	 Debugging mode: Configure the level 
of detail of error messages or set the 
error reporting method (errors can be 
sent by e-mail to the webmaster or 
logged to a file on the server).

•	 Login settings: Configure the user 
authentication options.

•	 E-mail settings: Configure the outgo-
ing e-mail server, port, user name, and 
password.

•	 CSS skins: Change the look of the 
entire site by selecting a different CSS 
skin.

•	 User interface persistence and data-
base caching: Enable these settings to 
speed up your work. If user interface 
persistence is enabled, all ImpAKT 
interfaces will remember the settings 
you entered the last time.

	 All ImpAKT interfaces feature contex-
tual help—short instructions that guide 
you through configuring each setting.
	 In addition to these settings, you 
can also configure an image processing 
library, perform product upgrades, or 
update your site.
	 The Login Settings section is the place 
where you configure all user authentica-
tion options, including database informa-
tion, password encryption, user levels, 
and redirect pages. Follow these steps to 
configure the login settings:
•	 In the InterAKT Control Panel, click 

the Login Settings icon. This opens a 
dialog box showing four tabs: Options, 
Database, Session, and User Levels.

•	 Configure the Options tab:
	 For increased security, passwords will 

be encrypted in the database
	 For this example, the forum will not 

use access levels, so set the restriction 
to use user name and password only

•	 Leave the Auto Login Validity value at 
its default setting. Users will be able to 
automatically log in to the forum. They 
will be asked to authenticate again 
only if 30 days have passed since the 
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last time they visited the forum.
•	 In the Database tab, define which table 

stores the user information and what 
columns to use for authentication:

	 Select the database connection (con-
nForum) and the table that stores user 
information (user_usr). The primary key is 
automatically detected and set to id_usr.
	 From the Username pop-up menu, 
select the name_usr column.
	 From the Password pop-up menu, 
select the password_usr column.
	 From the E-mail pop-up menu, select 
the email_usr column.
	 From the Active pop-up menu, select 
the active_usr column. If you specify a col-
umn that stores the account status (active/
inactive), account activation will be avail-
able. When a user registers an account, an 
e-mail message will be sent containing an 
activation link. Unless the user clicks that 
link, the account cannot be used.
	 In the Random key pop-up menu, 
select the randomkey_usr column.
	 A random key consists of a randomly 
generated set of alphanumeric characters 
used for improving website security. A 
random key is commonly used in user 
account activation, online purchases, 
or other activities that use URLs that 
ought to be difficult to guess. This pre-
vents potentially malevolent users from 
accessing the URLs by directly entering 
them in the browser window in order to 
activate accounts for other users. ImpAKT 
automatically generates unique random 
keys for each user and stores them in the 
specified column.
•	 In the Session tab, you can define 

which session variables to create upon 
login and what information to store in 
them. By default, two variables will be 
created: kt_login_id (stores the user’s 
unique ID) and kt_login_user (stores 
the user name). You don’t need addi-
tional session variables for this tutorial, 
so leave this tab as is.

•	 Because the forum does not use access 
levels, you need to define on the User 
Levels tab only those pages to redirect 
the user to. You have to set the login 
page and the pages to be redirected to 
when authentication succeeds or fails. 
Use the login.php page from the site 
root for the Login Page and Default 
Redirect on Fail text boxes. When the 
login is successful, the user must be 

redirected to the forum home page. 
•	 Click OK to apply the changes and then click 

Close to exit the InterAKT Control Panel.

	 Because sending e-mail notifications 
for account activation is part of the user 
registration process, you will also need to 
configure the e-mail settings as explained 
in the following section.

Configuring E-mail Settings
	 Forum users will receive several auto-
matic e-mail messages:
•	 Account activation e-mail
•	 Welcome message after activation
•	 Password reminder e-mail
•	 Topic reply notifications
	 This is why you need to set an out-
going e-mail server. You can configure 
e-mail settings from the InterAKT Control 
Panel by clicking the E-mail Settings sec-
tion.
	 In the dialog box that opens, you can 
configure the following:
•	 Outgoing server’s name or IP address; 

if you are not sure about this, consult 
your network administrator

•	 Port number (25 by default)
•	 Username and password used to log in 

to the mail server (if required)
•	 Default sender’s e-mail address; this 

will appear in the From field in all mes-
sage headers sent from the forum

	 Click OK to save the configuration, 
then click Close to exit the control panel. 
You have finished configuring user 
authentication for your site.
	 In the next section, you will build the 
user registration form.

Building the User 
Registration Page
	 To post messages, a user must have 
an active account. In this section, you will 
build the page that enables users to regis-
ter to the forum by filling in a user name, 
password, and valid e-mail address, and 
by uploading a profile photo—all without 
writing a single line of code.
	 The page you will work on is register.
php. The page layout is already created 
and is similar to the other forum pages.
	 You will build the registration form 
with the User Registration Wizard and 
then add a file upload feature with the 
Upload and Resize Image server behavior 
from ImpAKT.

Using the User Registration 
Wizard
	 To build the registration form, follow 
these steps:
•	 Delete the placeholder text (“Register 

form here”) from the main <div> tag.
•	 Go to the MX Kollection tab of 

the Insert bar and click the User 
Registration Wizard icon to open the 
wizard.

•	 Step 1 of the wizard displays the con-
nection and table settings you made in 
the InterAKT Control Panel.

•	 Click Next to proceed to Step 2, where 
you can define the form fields to 
display. The Form fields grid displays 
all the table columns that can be dis-
played as form elements. You can add 
or remove fields from the grid by click-
ing the Plus (+) and Minus (–) buttons 
on top of the grid.

•	 Remove the active_usr and random-
key_usr fields from the grid. Select 
each of them and click the Minus (–) 
button.

•	 Now do the following:
•	 The name_usr field is already config-

ured. It will be displayed as a text box 
labeled “Name”.

•	 Select the email_usr field, and change 
its label from Email to E-mail.

•	 From the Display As pop-up menu, 
select the photo_usr field and change 
it to a File Field control to allow users 
to upload their avatar image.

•	 The password_usr field is already con-
figured to be displayed as a password 
field, so you can move on to the next 
step of the wizard by clicking Next.

•	 In Step 3, you will define the validation 
rules for each form field. Because you 
configured the login settings in the 
InterAKT Control Panel, the validation 
rules for the user name, e-mail, and 
password fields are already in place. All 
three fields are required. The validity 
of the e-mail address is verified (which 
means users can’t type bogus text that 
is not an e-mail address). You do not 
need to change any settings in this 
step.

•	 In Step 4, you can define extra features 
for the registration:

	 To send a welcome message to a new 
user, check the Send Welcome E-mail 
option.
	 To enable account activation, check 
the Use Account Activation option. The 

1 • 2006 mxdj.com • 17



wizard will handle all the necessary 
details such as generating random keys, 
creating the activation page, and sending 
the activation e-mail message.
•	 Click Finish to complete the wizard and 

apply the changes.

	 The wizard generates the registra-
tion form with two password fields, cre-
ates the activate.php page that handles 
account activations, and adds the server 
behaviors that verify whether the user 
name is unique, the e-mail address is 
valid, and the two passwords match.
	 Save your page and upload all files 
to your testing server. If you preview the 
page in a browser.
	 Notice that required fields are 
marked with an asterisk (*) and the 
E-mail field has a hint indicating the 
correct format. Put your form to the 
test to see how it works. Try to register 
an account using an incorrect e-mail 
address. An error message will be dis-
played next to the e-mail field, but the 
data you entered is not lost.
	 You can also test the form to see what 
happens if you type two different pass-
words or if you try to register an account 
using a user name that already exists in 
the database.

Adding a File Upload 
Feature
	 Although you can choose a file in the 
Photo field, the image is not uploaded 
to the server. To build a functional file 
upload, you will use the Upload and 
Resize Image server behavior:
•	 Open the register.php page in 

Dreamweaver, go to Server Behaviors 

tab, and select Plus (+) > MX Kollection 
> File Upload > Upload and Resize 
Image.

•	 In the Basic tab, define where to get 
the images from and what to do with 
them:

•	 From the Form Field pop-up menu, 
select the form control for uploading 
files. You can only select form1.photo_
usr because this is the only file field on 
your page.

•	 From the Table Column pop-up menu, 
select the column that will store the 
filename: photo_usr

•	 From the Upload Folder pop-up menu, 
enter the path where the uploaded 
images will be saved. Click Browse and 
select the profiles folder.

•	 In order to save space on your server, 
resize the photos while keeping their 
aspect ratios. Choose Proportional – Fit 
to Box and make them 80 pixels wide 
by 80 pixels high..

•	 In the File tab, you can specify various 
security settings: the maximum file 
size allowed and the list of permitted 
file extensions. Use the default values 
for these options. You can also specify 
the preferred overwriting conflict reso-
lution. Leave the default Automatic 
Renaming method. (If a user uploads 

a file having the same name as 
another photo on the server, say 
angel.gif, it will be automatically 
renamed to angel_1.gif.)

	 You don’t need to configure 
anything in the Advanced tab 
(this is where you can register 
the file upload action to more 
transactions and assign it a 
priority). Click OK to apply the 
changes.
	 The image upload feature now 
works. Try registering a new 
account and uploading a photo. 
The photo is displayed when the 
user posts a message.
After registration, you will also 

receive two e-mail messages—one ask-
ing to activate your account and a wel-
come message.
	 You can edit the contents of the two 
e-mail messages by editing the cor-
responding HTML files located in the 
includes\mailtemplates\ folder.
	 In the next section, you will create the 
login form.

Building the Login Page
	 The layout of the login page is already 
created. You only have to apply the Login 
Form Wizard:
•	 Open the login.php page in 

Dreamweaver.
•	 Select and remove the placeholder text 

(“Login form here”).
•	 Go to the MX Kollection tab of the 

Insert bar and click the Login Form 
Wizard icon.

•	 This wizard consists of two steps. The 
first one is purely informative, dis-
playing the settings you made in the 
Control Panel. Click Next to continue.

•	 In Step 2 configure specific login 
options:

	 To enable users to remain logged 
in, select the Create “Remember Me” 
Checkbox option.
	 To build a page that automatically 
generates a new password for a user 
and sends it by e-mail, select the Create 
“Forgot Password” Page option.
•	 Click Finish to complete the wizard 
and apply the changes.

	 The wizard automatically generates 
the application logic to verify whether 
the user and the password are correct 
and whether the account is active. It also 
generates the forgot_password.php file 
and a link to it in the login form.
	 Save the page and upload it to the 
server. Make sure you also upload the for-
got_password.php file. You can test the 
login form in your browser to see how 
it works. If you log in as an inactive user 
(user name: Angel, password: root), you 
will receive a warning message.
	 In the next section, you will create a 
logout link that safely destroys all session 
variables.

Creating the Logout Link
	 Although an automatic logout takes 
place when the session expires or the 
browser window is closed, you must add 
an explicit logout link which enables 
users to clear the session information 
safely. You must add this link to the fol-
lowing forum pages:
•	 reply_message.php
•	 view_message.php
•	 post_message.php
•	 index.php
	 The following steps explain how to 
create the link on the forum home page. 
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You will need to repeat the steps for the 
other pages as well:
•	 Open index.php in the Code view.
•	 Place the cursor after the Login link in 

the top-right <div> container (the one 
with the white links inside).

•	 Apply the Logout User server behav-
ior from the Server Behaviors tab by 
selecting Plus (+) > MX Kollection > 
User Login.

•	 Configure the dialog box:
-	 Select the first option button; the 

the logout operation will be trig-
gered by a link. From the pop-up 
menu, select Create New Link: 
“Logout”.

-	 After users log out, they will be 
redirected to the forum home page. 
Click the Browse button and select 
the index.php page.

-	 Click OK to apply the server behavior.
	
	 Notice that the Logout link is created.
	 Repeat these steps for the reply_mes-
sage.php, view_message.php, and post_
message.php pages.
	 Not all links must be visible all the 
time. Logged-in users have no need to 
see the Login and Register links, just as 
the Logout link means nothing for the 
user who hasn’t logged in or doesn’t have 
an account. In the next section, you will 
use conditional regions to control which 
links are displayed and when.

Hiding Content with 
Conditional Regions
	 To control what links are displayed 
when users are logged in and what to dis-
play when they are not, you will use a con-

ditional region added by ImpAKT: Show If 
User Is Logged In. You can access it from 
the Server Behaviors tab by selecting Plus 
(+) > MX Kollection > Conditional Regions.
	 Follow these steps to display the log-
out link for logged-in users and the oth-
ers for the rest:
•	 Open the index.php page.
•	 Select the Logout link in the top-right 

corner.
•	 Apply the Show If User Is Logged In 

server behavior.
	 For the restriction type, select the 

Username and Password option.
	 Check the Has ELSE option. Text in the 

ELSE region will be displayed if the 
condition is not met (the user is not 
logged in).

•	 Click OK to apply the server behav-
ior. In Dreamweaver, a gray border 
appears around the Logout link, along 
with some placeholder text (Else text: 
Replace this).

•	 Select the Register | Login text and cut 
it from the page.

•	 Select the placeholder text (Else text: 
Replace this) and remove it. Then paste 
the Register and Login links from the 
Clipboard.

•	 Save the page and preview it in a 
browser. Because you are not logged in.

	 Try to log in using one of the sample 
user accounts. Notice that only the Logout 
link is visible. Repeat the previous steps 
for the view_message.php, post_message.
php, and reply_message.php pages.
	 That’s it! You have successfully built 
a user authentication system for your 
forum.  

tions. Especially since it is Kevin himself 
who oversees Adobe’s developer relations 
program.
	 As he wrote just recently, in the last 
issue of MXDJ—in the article based on his 
industry-respected blog:
	 “There is clearly a resurgence in how 
HTML can be used to deliver application 
user interfaces and terrific progress has 
been made on that. In addition, Flash 
brings capabilities that HTML doesn’t cur-
rently have, and they can be used together 
to great benefit -- in fact, Flash has already 
been architected to fit perfectly in the Web 
2.0 model. 
	 For example, Adaptive Path has been 
working on a great new application called 
MeasureMap that helps people track traf-
fic on their blogs and is being built with 
a combination of HTML and Flash on the 
client. Another is how Flickr is using both 
HTML and Flash, for example implement-
ing the organizer and slideshow with 
Flash and the photo index with HTML. The 
language in Flash is ActionScript which 
is the same as JavaScript, both ECMA 
standard languages, and it’s very simple 
to call between code in HTML and Flash, 
enabling smooth integration with a free 
open-source integration kit.” 
	 In the February issue of MXDJ, I’m 
delighted to give you a heads-up that 
Adobe’s Christian Cantrell—the author of 
numerous tutorials and white papers as 
well as being coauthor of Flash Enabled: 
Flash Design & Development for Devices 
and of the JavaScript/Flash Integration 
Kit—will be writing for us about AJAX to 
Flash integration, on which he’s probably 
leading expert in the world.	
	 The Adobe product roadmap, mark 
my words, will continue to keep you as 
developers  far ahead of Microsofties and 
Ajaxians and all the rest. As it emerges 
later in the year, you’ll be blown away. 
Meantime, enjoy this issue. And do please 
keep your 2006 feedback and suggestions 
coming, by e-mailing 2006@sys-con.com. 
“None of us is as smart as all of us,” as they 
say!  

The next part of this 

article can be found 

at www.macromedia.

com/devnet.

– continued from page 7

Adobe Has Inherited 
Web History from 
Macromedia…
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lash has been communicating 
with JavaScript for a long time 
through getURL and fscommand, 

but with Flash 8 it’s easier than ever. With 
the ExternalInterface class, you cannot 
only call JavaScript functions, but also 
have JavaScript call Flash functions. And 
now that JavaScript is getting more 
and more publicity in the form of AJAX 
(Asynchronous JavaScript and XML), the 
ability to seamlessly integrate your Flash 
content within your HTML content is 
essential.
	 This article is going to cover some 
basic uses of ExternalInterface and move 
into some of the more undocumented 
ways to use it. Then we will finish up 
by building a small image injector 
that will take a selected image from 
one browser window and push it into 
another HTML page without the use of a 
LocalConnection object.

ExternalInterface Basics
	 The method being used to make calls 
to JavaScript is the static call method of 
the ExternalInterface class. Here is the 
basic syntax for calling this method:

ExternalInterface.call(function:

string, parameters:object);

	 The first parameter is the name of 
the function you’re calling as a string.  
And following that parameter are all the 
parameters (separated by commas) for 
the function being called. The param-
eters being passed to the JavaScript 
function can be any valid ActionScript 
data type.
Here is an example of calling a function in 
JavaScript:

//first, import the necessary class

import flash.external.

ExternalInterface;

//call the helloWord function

ExternalInterface.call(“helloWorld”, 

getTimer());

	 Not only are we calling the helloWorld 
function in JavaScript (which we will write 
next), but we are passing it the number of 
milliseconds that have passed before the 
function is called using getTimer(). The 
next step is to publish the SWF and the 
HTML file, then open the HTML file and 
place this code after the closing </head> 
tag.

<script>

   function helloWorld(ms){

      alert(“It took “+ms+” millisec-

onds to say hello world”);

   }

</script>

	 What this function will do is take the 
amount of milliseconds being passed to it 
and use it in a statement that will appear 
in an alert box.
	 Now you can save the HTML file and 
publish it along with the SWF file up to 
a web server to test it, where you should 
see an alert box similar to the following 
image.
	 The reason the files must be on a 
web server instead of being able to test it 
locally is because of the Flash 8 security 
sandbox. The allowScriptAccess param-
eter (found in both the object and the 
embed tag) in the HTML has a default 
value of “sameDomain”, which means that 

the file will not allow calls to JavaScript 
from Flash while running locally on your 
machine (or from Flash files running from 
different domains). You can of course fix 
that by changing the value of allowScrip-
tAccess to “always” in both places.

Returning Values
	 With ExternalInterface, you can also 
get a return value if the JavaScript func-
tion you’re calling has one. To get the 
return value, just set a variable directly to 
the ExternalInterface.call() you are mak-
ing like this:

var squareNum = ExternalInterface.

call(“square”, 4);

	 Providing you have a JavaScript func-
tion that will do the work, the variable 
squareNum will now have a value of 16.
	 A more practical example might be 
when a user has forgotten his or her pass-
word. Most systems will send an email 
with either the password or a link to a 
page where the password can be reset, 
but some systems require you to be able 
to answer a simple question that was set 
by the user such as “What is the name 
of your pet?” or “What is your mother’s 
maiden name?”. These questions are usu-
ally presented on a separate page, but 
they could be easily presented right from 
the current page in a prompt box like the 
following example.
	 As you can see from the following 
image, the setup for the stage is your 
general User Name/Password style 
setup, but the “Forgot Password” Button 
component has an instance name of for-
got_butn.  And then the ActionScript in 
the first frame will look like this:

Building an 
Image Injector

Using ExternalInterface to update HTML
by david vogeleer

javascript

f
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//import the class we need

import flash.external.

ExternalInterface;

//the question and answer

var question:String = “Who is your 

favorite cartoon character?”;

var answer:String = “Bender”;

forgot_butn.clickHandler = function(){

   //call the prompt and wait for the 

answer

   var returnedAnswer = 

ExternalInterface.call(“prompt”, ques-

tion);

   //make sure the user didn’t hit 

cancel

   if(returnedAnswer){

      if(returnedAnswer == answer){

         var msg:String = “That is 

correct!  Your password has been 

emailed to you.”;

      }else{

         var msg:String = “That is 

incorrect!”;

      }

      //send the results to an alert 

box

      ExternalInterface.call(“alert”, 

msg);

   }

}

	 The code above should look some-
what familiar. It initially imports the 
class we need to work with JavaScript. 
Then both the question and the answer 
variables are set. Next is the event for 
when a user clicks the “Forgot Password” 
button, which directly calls the prompt 
function without any need for a custom 
JavaScript function. Once a user has filled 
in the answer to the prompt question, the 
result is returned to returnedAnswer for 
comparison against the real answer. As 
long as the user does not press the cancel 
button in the prompt, they will receive 
an alert telling them whether or not the 
answer is correct.
	 You can publish this file and the HTML 
up the server, and then click “Forgot 
Password” to see a prompt similar to 
the following image. And of course this 
technique becomes even more powerful 
when hooking it into a backend database 
to make it dynamic.
	 As mentioned earlier, notice how the 

code in this example has no need for 
custom functions in JavaScript. Instead, 
you can directly call all the available 
JavaScript functions directly from Flash, 
but not just functions.

Setting Properties
	 Although it is undocumented, you 
can in fact set properties in JavaScript 
right from Flash using ExternalInterface. 
The key to setting properties from the 
call method is using an equal sign (=) 
after the property name in the first 
parameter, and then putting the new 
value of that property as the second 
parameter. Here is an example that will 
set the background color of the HTML 
page to red:

ExternalInterface.call(“document.

bgColor=”, “#ff0000”);

	 As a more practical example, you can 
also set properties of individual elements 
using first the getElementById method 
of the document object and then set 
the content of that element using the 
innerHTML property.

	 The first thing you will need in this 
new file is a TextArea component and a 
Button component. Give the TextArea an 
instance name of text_ta and the Button 
an instance name of submit_butn with 
the label property of “Submit” like the fig-
ure below. Then the ActionScript to make 
it work looks like this:

//import the class we need

import flash.external.

ExternalInterface;

//when the button is clicked, send 

the text

submit_butn.clickHandler = function(){

   ExternalInterface.call(“document.

getElementById(‘content’).innerHTML=”, 

text_ta.text);

}

	 Notice we are looking for an element 
with the id attribute of “content”. We 
have to put that into the HTML next, so 
publish both the SWF and the HTML. 
Then open the HTML doc and add this 
line after the closing </object> tag for 
the SWF:
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<div id=”content”></div>

	 This is where the content is going to 
appear. Save the file and push both the HTML 
and the SWF to a web server (or change the 
allowScriptAccess properties to “always” for 
local testing) and test it. You will see that 
when you click the submit button, the text in 
the TextArea component will appear under 
the SWF. And because your sending text that 
will render as HTML, you can use HTML tags 
like the following figure shows.

	 You can also change properties and 
call functions in another HTML window, 
as you will see in the final example.

Building the Image Injector
	 Now let’s take what has been cov-
ered so far and apply it to a real world 
example by building an image injector. 
The idea for this example is that there can 
be a pop up window that will control an 
image in the opening window. This is use-
ful for testing different looks of a page, or 

in conjunction with a content manage-
ment system (which is why the injector 
was originally created).
	 The first part of the injector example 
will be the page that will be receiving the 
new images. Open up Dreamweaver, start 
a new HTML page and place this code in 
it:

<html>

<head>

<title>My Favorite Picture</title>

</head>

<script>

function openInjector() {

	window.open(‘swapPic.html’,’changer’,

’toolbars=no,resizeable=no,scrollbars=

no,width=410,height=410’);

}

</script>

<body>

<h3>This is my Favorite image:</h3>

<a href=”javascript: 

openInjector();”><div 

id=”imageLoader”><img src=’imgs/water.

jpg’ border=”0” /></div></a>

<p>(click the image to change it)</p>

</body>

</html>

	 The above HTML does a few things 
that are important. First it creates the 
JavaScript function for when someone 
clicks on the image. That function will 
open the pop up, which we will create 
later (“swapPic.html”). We also create 
the <div> tag we need with a default 
image already in it. And the entire div is 
wrapped with an <a> tag that will make 
it so when the user clicks the image, the 
JavaScript function will be called, and the 
pop up will appear.
	 Before the actual injector is built, 
there are a couple of PHP pages that 
will make the injector easier to manage. 
The first is a page that will grab all the 
JPEG images from a given directory and 
return them to Flash. The second page 
will create thumbnails of those images for 
displaying in Flash. Because the full size 
images can be of different size, it’s impor-
tant to make the thumbnails consistent 
for being displayed in the injector.

fileList.php

<?php
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$fileList;

$picDir = $_POST[‘sentDir’];//get the 

directory

$dir = opendir($picDir);//open the 

directory

while($file = readdir($dir)){

   //we only need the JPEGS for this 

example

   if(substr_count($file, “.jpg”) > 

0){  

      $fileList .= $file . “~”;

   }

}

//close the directory

closedir($dir);

//send the files back to Flash

echo “files=” . $fileList

?>

 	 This file opens the directory passed to 
it from Flash, and returns a string of all 
the JPEG images separated by a tilde (~) 
character.

makeThumb.php

<?php

// The file, thumbnail size and zoom 

level

$filename = $_GET[‘sentFile’];

$thumbSize = $_GET[‘sentSize’];

$imgZoom = $_GET[‘sentZoom’];

// Content type being returned

header(‘Content-type: image/jpeg’);

// Get new dimensions

list($width, $height) = 

getimagesize($filename);

if($width > $height){

	$new_width = $height * $imgZoom;

}else{

	$new_width = $width * $imgZoom;

}

//Set the starting point for the 

thumbnail creation

$sX = ($width-$new_width)/2; 

$sY = ($height-$new_width)/2; 

// create the image from the original

$image_p = imagecreatetruecolor($thumb

Size, $thumbSize);

$image = imagecreatefromjpeg($filena

me);

imagecopyresampled($image_p, $image, 

0, 0, $sX, $sY, $thumbSize, $thumb-

Size, $new_width, $new_width);

// output JPEG

imagejpeg($image_p, null, 100);

?>

	 When this file is called from Flash, you 
pass it three parameters:
•	 sentFile: the path to the JPEG file to 

use.
•	 sentSize: the width and height the 

thumbnail needs to be returned in.
•	 sentZoom: a floating point number 

between 1-0. The smaller the number, 
the more it zooms in.

	 This file does a lot. First it gets the 
current dimensions of the image. Then 
it uses those dimensions to get the larg-
est square portion of the center of the 
image it can. Finally, it creates the new 
image and returns it back to Flash as a 
JPEG.
	 Now the HTML and the PHP pages are 
done, the final piece is the injector itself. 
Before anything is created on the 
stage, save this file as “swapPic.fla”. 
Then create a second layer and call 
the top one ActionScript and the bot-
tom one content. Reset the stage to 
400x400 to fit nicely in the pop up. 
There is only a small header and a hori-
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zontal bar in the content layer because 
most of the interface will be built with 
ActionScript.
	 In the ActionScript layer, place this 
code:

import flash.external.

ExternalInterface;

import flash.filters.DropShadowFilter;

//a filter to give the thumbnails a 

little depth

var myDrop:DropShadowFilter = new 

DropShadowFilter(4,45,0x000000,100,4,

4,1,3);

//the directory to get images from

var dir:String = “imgs”;

//main path to files

var mPath:String = “http://www.yourS-

erver.com/”;

//the function called when a thumbnail 

is selected

function sendFile(fl){

   ExternalInterface.call (“opener.

document.getElementById(‘imageLoader

’).innerHTML=”, “<img src=’”+dir+”/

”+fl+”’ border=’0’ />”);

}

//the LoadVars object for collecting 

the image names from fileList.php

var imgs_lv:LoadVars = new LoadVars();

imgs_lv.onLoad = function(success){

   if(success){

      //the initial setting for col-

umns and rows

      var c = r = 0;

      var imgs_array = this.files.

split(“~”);

      var tLength = imgs_array.length 

- 1;

      var i = -1;

      while(++i < tLength){

         var img:MovieClip = createEm

ptyMovieClip(“img”+i+”_mc”, i+1);

         img.createEmptyMovieClip(“ta

rget_mc”, 1).loadMovie(mPath+”makeThum

b.php?sentFile=”+dir+”/”+imgs_array[i]

+”&sentSize=40&sentZoom=1”);

         img._x = (c*50)+20;

         img._y = (r*50)+55;//the 

plus 55 is to fit under the title at 

the top

         c++;

         if(c == 7){

            c = 0;

            r++;

         }

         //when a thumbnail is 

selected, call the function

         img.file = imgs_array[i];

         img.onRelease = function(){

            sendFile(this.file);

         }

         //set the dropshadow

         img.filters = [myDrop];

      }

   }else{

      ExternalInterface.call(“alert”, 

“An error occured with the images.”);

   }

}

//go get the images

imgs_lv.sentDir = dir;

imgs_lv.sendAndLoad(mPath+”fileList.

php”, imgs_lv, “POST”);

	 Most of this code is for control-
ling the alignment of the thumb-
nails. The first part grabs the two 
classes we need, including the Flash 8 
DropShadow class to add some depth 
to the thumbnails. After that, we cre-
ate a variable to hold the directory 
we are going to pass to the PHP script 
as well as a variable to hold the main 
path to the PHP scripts. The next part 
is the function that will be called when 
a thumbnail is clicked. Notice that in 
the call method, we are not only pass-
ing the property we want to access 
(the innerHTML property of the ‘image-
Loader’ element), but we are also 
using the keyword opener before we 
access it. What this keyword does is tell 
JavaScript we want to access the ele-
ment in the HTML page that opened 
this HTML page. This means that not 
only can we access all the properties 
of the current HTML page we’re in, but 
other HTML pages as well (provided 
they are on the same domain when 
setting allowScriptAccess to “sameDo-
main”).
	 After that, a LoadVars object is 
created to handle the communication 
between the PHP and Flash. Within 
its onLoad event, a while loop is 
used to cycle through all the images 
and create thumbnails. This is where 
the makeThumb.php script comes in 
handy, because we know each image 
being returned will consistently be 
the same size. While we are creating 

the thumbnails, we set the onRe-
lease event for them so when they 
are clicked, the sendFile function 
will be called updating the image in 
the other HTML page. Finally, we set 
the sentDir property of the LoadVars 
object and fetch all the images in that 
directory. 
	 The only thing left to do is to publish 
and test it. So after you load the SWF, 
HTML and PHP pages (or pages that do 
the same thing as the PHP ones) to your 
server, you should be able to load the 
initial page, click on the image, which 
will open the Image Injector pop up, and 
swap out images in real time to see which 
one fits the best.
	 What’s next? As much as I hate to 
use a cliché’, you are bound only by 
your imagination. From some of the 
techniques in this article, you can see 
that not only do you have total access to 
JavaScript from Flash, but you can call 
functions, methods and even set proper-
ties of different pages from a single pop 
up window. Imagine being able to control 
layout and colors of one window from 
another, it will save a lot time on trial and 
error designing. 
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hen it comes to design-
ing and optimizing 
web graphics, it doesn’t 

get much better than Macromedia 
Fireworks—given its available tools and 
workflow. However, Fireworks is not 
necessarily limited to the tools that come 
with it in the default installation. You 
can modify the interface to include new, 
custom panels that unlock hidden func-
tionality, introduce new functionality, or 
simply improve your workflow.
	 As a developer and designer, I find 
such extensions to the Fireworks inter-
face invaluable in helping me quickly and 
easily obtain my graphics goal. In Part 1 
of this tutorial, I will show you how you 
too can make your own custom panels 
for Fireworks using Macromedia Flash. 
Not only will I show you how they are 
made but I will also cover workflow tips 
for making panels and techniques to help 
you successfully debug them.

Understanding SWF Panel 
Interactions
	 Custom panels in Fireworks are made 
with Flash. They consist simply of a Flash 
SWF file, which Fireworks plays using an 
internal Flash player embedded within 
a panel window that looks and oper-
ates like any other panel that’s native to 
the application. The SWF provides the 
panel with its own interface and a means 
for interacting with Fireworks using 
ActionScript. If you’ve ever used the Align 
panel in Fireworks, you’ve seen a custom 
SWF panel at work.
	 A custom panel window is capable 
of receiving commands from the SWF 
it’s playing through ActionScript. One 
ActionScript command in particular 

instructs the window to relay informa-
tion—or, more specifically, a JavaScript 
command—from the SWF to the main 
Fireworks application. This command is 
the MMExecute() command:

MMExecute( JavaScriptCommand:String ) 

: String; 

	 MMExecute has one parameter, a 
string representing a Fireworks JavaScript 
command that is to be sent to Fireworks. 
When Fireworks receives this command, 
it runs it just as though it were on the 
Commands menu. When the command 
has completed, MMExecute also returns 
any result of that command back to Flash 
in the form of a string. This allows the 
SWF to react to any command sent by 
MMExecute if needed.
	 In its simplest form, MMExecute 
is about all you need to create a 
simple panel and use it to interact with 
Fireworks. You can see how simple it is 
with the first example, the Create Ellipse 
panel.

Example 1: The Create 
Ellipse Panel
	 This example represents your basic 
first panel example, similar to “Hello 
World” examples you might encounter 
when learning programming languages. 
Because Fireworks is a graphics editing 
program and not a new programming 
language, I will use an ellipse in place of 
“Hello World.”
	 The Create Ellipse panel creates an 
ellipse in the current Fireworks docu-
ment. The panel interface consists of a 
single button that, when clicked, creates 
the ellipse. As you might have guessed, 

MMExecute is used to instruct Fireworks 
to draw the ellipse when the button is 
clicked. The code for actually creating the 
ellipse can be written by hand if you are 
familiar enough with Fireworks JavaScript 
programming. But it’s easier to extract it 
from the History panel after you first draw 
one yourself in Fireworks.
	 The History panel in Fireworks is 
much like the history panels in other 
applications that record your every 
action, step by step, within the pro-
gram. In Fireworks, however—as well as 
other Studio applications such as Flash 
and Dreamweaver—the History panel 
records not only your steps but also the 
JavaScript command(s) used to generate 
those steps. You can therefore copy the 
JavaScript associated with any step(s) in 
your history to the Clipboard and reuse it 
elsewhere, such as in your custom com-
mands or, as you will see in this example, 
custom panels.

Creating the Code for the 
Panel
	 Here is the procedure to get the code 
you need to create this panel:
•	 Open a new Fireworks 8 document. 

Within it, draw an ellipse that you 
would like Create Ellipse to generate 
for you.

•	 In the History panel, find the Ellipse 
command, select it, and use the 
Copy icon to copy the script to the 
Clipboard.

•	 Launch Flash 8 and open the Create 
Ellipse template.

•	 Source Files/Templates/Create Ellipse.
fla

•	 It should consist of a Button compo-
nent with the label “Create Ellipse.”

Creating 
Fireworks Panels

Custom panels that unlock hidden functionality
by trevor mccauley

panels

w
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•	 In Flash, select the Create Ellipse but-
ton and open the Actions panel, adding 
the following script:

on(click){

MMExecute(“”);

}

	 In the quote string in the MMExecute 
call, paste the Fireworks JavaScript com-
mand you copied from the History panel 
in Fireworks. You should have something 
that looks like the following:

on(click){

MMExecute(“fw.getDocumentDOM().

addNewOval({left:6, top:5, right:98, 

bottom:61});”);

}

	 Publish your movie to create the SWF.
You now have a SWF containing a but-
ton that, when clicked, uses MMExecute 
to send a command to the Macromedia 
application running the SWF. Ideally this 
should be Fireworks but simply publish-
ing the SWF does not make Fireworks 
recognize it as a panel.

Making Fireworks 
Recognize the SWF
	 Fireworks recognizes custom panels 
by scanning for SWF files located in the 
Configuration/Command Panels folder 
within the Fireworks installation folder 
whenever the application launches. Each 
SWF located there is interpreted as a 
panel and is listed along with those avail-
able in the Windows menu. The name 
given to the panel in Fireworks is simply 
the SWF’s filename, not including the 
extension.
For your Create Ellipse SWF to be recog-
nized as a panel, you must put it in the 
Command Panels folder:
•	 Locate your Create Ellipse panel’s SWF. 

If you are using the default publish 
settings for your Create Ellipse Flash 
document, it should reside in the same 
folder as the FLA itself.

•	 Find the Configuration/Command 
Panels folder in your Fireworks 8 instal-
lation folder.

•	 Place a copy of your published Create 
Ellipse.swf file in the folder:

•	 (Windows) C:\Program Files\
Macromedia\Fireworks 8\
Configuration\Command Panels (Mac 

OS) Macintosh Hard Drive:Applications:
Macromedia:Fireworks 8:Configuration:
Command Panels

•	 Restart Fireworks.
•	 Open the Windows menu and select 

Create Ellipse.
•	 You should now see Create Ellipse.

swf within the Fireworks interface as a 
panel.

•	 Create a new Fireworks document.
•	 Click the Create Ellipse button.

	 You should see a new ellipse created 
in your Fireworks document. Its size and 
shape should match exactly the one you 
created previously in Fireworks in order to 
get the command code from the History 
panel.

Workflow Tips for Fireworks 
JavaScript
	 The Create Ellipse panel was pretty 
straightforward. As you begin to make 
more complex panels, however, it will 
become important to develop a process 
that makes creating and testing your 
panels as painless as possible. This is 
important because you’re not only deal-
ing with two applications but also two 
programming languages that must inter-
act to make your custom panels work. 
Developing a good workflow can help 
make the process run smoothly.

Test Fireworks Scripts 
in Fireworks First
	 Although custom Fireworks pan-
els use Flash SWF files to operate, the 
real functionality of the panel lies 
within the Fireworks JavaScript code that 
MMExecute sends to Fireworks from the 
SWF. When you decide to make a panel, 
it is often a good idea to start by creat-
ing Fireworks JavaScript scripts sepa-
rately and testing them directly within 

Fireworks without a panel interface. That 
way, when you start working in Flash, you 
can at least know that you are working 
with functional Fireworks commands.
	 Dreamweaver 8 happens to be a 
great editor for creating and testing 
Fireworks JavaScript files. Although 
Dreamweaver 8 supports Fireworks 
JavaScript files, it does not inherently 
treat them like other JavaScript (.js) files. 
Included with this tutorial’s source files is 
an extension which allows Dreamweaver 
to recognize JSF files as normal 
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JavaScript files, providing code coloring 
and code hints:
•	 Open DW_JSFSupport.mxp with the 

Macromedia Extension Manager.
•	 Restart Dreamweaver.

	 Also included with the source files is 
another extension, a Command Prompt panel for 
Fireworks. This custom panel provides a very sim-
ple text editor for writing and executing Fireworks 
JavaScript from directly within Fireworks.
	 Here’s how you install the Command 
Prompt extension:

•	 Open FW_CommandPrompt.mxp with 
the Macromedia Extension Manager.

•	 Restart Fireworks.
•	 Access the Command Prompt panel 

from the Window menu in Fireworks.

Use the Fireworks History 
Panel to Help
	 As you saw when creating the Create 
Ellipse panel, having access to the com-
mands created by Fireworks through its 
History panel is a great time-saver. Use it 
whenever you can to create commands 
quickly for your scripts rather than typing 	
them by hand. You may even be able to 
learn something new by looking at the 
code generated by the History panel.

Keep a Fireworks 
JavaScript 
Reference Handy
	 Many Fireworks commands go 
beyond what you can retrieve from 
the History panel. When you create 
custom scripts, it is always a good 
idea to keep the Extending Fireworks 
documentation open and available 
for quick reference (available from the 
Help menu in Fireworks 8). Chances 
are good that you will need it—and 
need it often.
	 I suggest downloading the PDF ver-
sion (ZIP, 1.2 MB) instead of the Help 
system. I find that searching within the 
PDF is more accurate than searching 
through Help. Plus you get to have every 
page open and easily accessible, unlike 
the segmented Help system. Be sure to 
keep up with the Fireworks 8 LiveDocs for 

any corrections and suggestions made by 
other Fireworks users.

Reuse Your Scripts
	 When you work with Fireworks 
scripts, you may find that some scripts 
come in use over and over again. 
Keep a repository of these scripts 
so that you can easily reuse them if 
needed. If you are using Dreamweaver 
to write your scripts, make use of 
Dreamweaver’s code snippets fea-
ture. For more information about the 
Snippets feature in Dreamweaver, see 
Working with Code Snippets in the 
Dreamweaver LiveDocs.

Publish Your Panel SWF 
Directly to the Command 
Panels Folder
	 By default Flash publishes a SWF in 
the same folder that the FLA is located. 
For Fireworks to recognize a SWF as a 
panel, however, it needs to exist within 
the Command Panels folder located in 
the Fireworks installation folder. To avoid 
the hassle of manually putting it there 
yourself, you can instruct Flash to publish 
the SWF directly to that folder. There are 
two ways to do this:
•	 Save your panel FLA within the 

Command Panels folder so that each 
time the SWF is published, it is auto-
matically published to that folder as 
well.

•	 Recommended: Save your panel FLA 
wherever you want but adjust your 
FLA’s publish settings (in Flash choose 
File > Publish Settings) by selecting the 
Command Panels folder as the destina-
tion folder for your published SWF.

	 Because Fireworks requires a panel 
SWF to reside in the Command Panels 
folder during startup, it’s a good idea 
to publish your SWF immediately after 
creating your FLA, followed by a restart 
of Fireworks. That will make Fireworks 
recognize your SWF as a panel immedi-
ately. Then you can republish your SWF 
as needed to update that panel. Each 
time you publish, all you need to do is 
close and reopen the panel to reload the 
newest version of the SWF used by that 
panel.

Note: There are two ways to get rid of a 
panel in Fireworks: closing it and hiding 
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it. When you reopen a panel, if it was hid-
den, it will not reload the SWF. The SWF is 
only reloaded if the panel is reopened after 
having been closed. To close a panel you 
must either right-click its title bar and select 
Close Panel Group or click the close button 
available to the panel when it’s undocked. 
Hiding a panel happens when you reselect 
the panel name in the Windows menu 
when it is already opened. For undocked 
panels, hiding a panel in this manner 
makes it appear as though the panel were 
closed.

Test Incrementally
	 If you are dealing with a fairly com-
plex panel—or one including many 
operations or options—it will be helpful 
to test each part of the panel separately. 
This lets you isolate problems as they 
occur and helps you deal with them more 
effectively. Attempting to debug a panel 

when you don’t know what’s causing the 
problem is much more aggravating.

Debugging Fireworks 
Commands
	 Flash has quite a few tools to help 
developers debug panels specifically 
designed for it. Fireworks, on the other 
hand, has nothing of the sort. In fact, if 
you’re lucky Fireworks will probably tell 
you simply that an error occurred by 
issuing an alert . This can make Fireworks 
scripts quite difficult to debug.
	 There’s a two-step process involved 
when Fireworks receives a Fireworks 
JavaScript command. First it evaluates 
the script and then it executes the script. 
A problem can occur at either step—and 
either step can produce an error alert. 
Such alerts, however, will not always be 
invoked if the script is run from within 
a Flash panel—a reason why testing 
outside of the panels themselves can be 
beneficial.
	 When Fireworks encounters a prob-
lem with evaluation, no script will be exe-
cuted and an error will be immediately 
issued. This usually means there’s been a 
syntax error such as mismatched brack-
ets ( {} ) or a misuse of operators. There 
will be no indication of where the error 
occurs. It will be left up to you to find out 
where that is. More advanced external 
script editors like Dreamweaver 8 should 
help you find such errors, thanks to fea-
tures such as color coding. The following 
example will create an error in Fireworks 
due to an error in script evaluation:

function copy () {

	 fw.getDocumentDOM().clipCopy();

copy(); 

	 The problem with the above script 
is that the copy function block was not 
closed with an ending bracket ( } ). As a 
result, Fireworks kills the command and 
issues an error before anything even gets 
to be executed.
	 Getting a script to evaluate correctly 
is half the battle. An error can still occur 
if there is a problem with execution. If 
that happens, Fireworks will issue an alert 
directly after reaching the problematic 
code. Problems in execution usually result 
from attempting to use a variable or func-
tion that does not exist or calling a native 

Fireworks method with incorrect argu-
ments. The following example will create 
an error in Fireworks due to an error in 
script execution:

function copy () {

	fw.getDocumentDOM().clipCopy();

}

copie();

	 Now the copy function is correctly 
defined here but when it is called at 
the bottom of the script, it’s misspelled. 
Because the copie function doesn’t actu-
ally exist, there is an error when Fireworks 
attempts to call it, which kills the script 
and issues the error alert.
	 Although the error message for 
both the previous examples is the same 
(“Could not run the script. An error 
occurred.”), there is a slight advantage in 
dealing with errors resulting from execu-
tion. That advantage is the simple fact 
that code prior to the faulty code is cor-
rectly executed before Fireworks issues 
the error. This allows you to find out at 
least how far a script has gone before 
reaching bad code, or even if it manages 
to execute any code at all. The most com-
mon indicator is a simple JavaScript alert. 
Consider the following script:

alert(“Defining copy function”);

function copy () {

	fw.getDocumentDOM().clipCopy();

}

alert(“Calling copy function”);

copie();

alert(“Script Complete”);

	 When you run this script in Fireworks, 
you get three alert messages, “Defining 
copy function,” “Calling copy function,” 
and the inevitable error, “Could not run 
the script. An error occurred.” The fact 
that “Defining copy function” is alerted 
tells you immediately that the script was 
evaluated correctly and that there are 
no errors with the syntax. Seeing “Calling 
copy function” tells you that copy was 
defined correctly and that it is about to 
be called within the script. Given that 
the error message is seen instead of the 
“Script Complete” alert indicates that 
there was something wrong with the call 
to the copy function. Upon closer inspec-
tion, the spelling error can be identified 
and corrected.
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	 The previously mentioned Command 
Prompt extension is a great way to help 
test scripts in Fireworks. Keep in mind, 
however, that because the Command 
Prompt extension is a custom SWF panel, 
it may fail to provide some Fireworks 
error alerts when it encounters a problem 
in the script. Including your own alerts 
when using the Command Prompt is 
nonetheless beneficial in determining 
whether a script is correctly interpreted 
or whether or not it is executed com-
pletely and successfully by Fireworks.
	 Fireworks actually provides a means 
to help you debug SWF panels as they 
send the script to the application. It 
provides two Fireworks JavaScript 
methods—fw.enableFlashDebugging() 
and fw.disableFlashDebugging()—that 
let you turn debugging mode on and 
off for commands sent to Fireworks. 
Don’t get too excited, though. All that 
this debugging includes is an alert of 
the script being sent to Fireworks from 
a call to MMExecute. Chances are that 
you, being the panel developer, already 
know what that script is so using these 
methods may only help so much. 
Calling fw.enableFlashDebugging 
turns on this alert feature, while 
fw.disableFlashDebugging turns it off.
	 Here are some things to consider 
when debugging:
•	 Check the spelling of functions and 

variable names. Capitalization counts.
•	 Remember that MMExecute uses a 

string for Fireworks JavaScript com-
mands, so watch for quotes and char-
acter-escaping when sending a string 
from Flash to Fireworks. For example, 
this code will not work:

•	 MMExecute(“alert(“Hello”);”);
•	 The open quote in the alert text actu-

ally closes the quote string used in 
MMExecute. Instead, you can use 
single quotes or escape nested double 
quotes with the backslash character:

•	 MMExecute(“alert(\”Hello\”);”);
•	 Try to use functions as much as pos-

sible. This helps you more easily find 
where a problem may exist and facili-
tates code reuse.

	 If you find something that isn’t 
working right, and you think it should, 
check the Fireworks LiveDocs. You’ll find 
corrections to the Help documentation 
there and possibly solutions to whatever 

problem you may be encountering. Also 
feel free to ask questions in the Extending 
Fireworks Forum.
	 Now that you have a better under-
standing of debugging and improve-
ments that can be made to your work-
flow, it’s time to start with a new, slightly 
more complex example: the Mirror panel.

Example 2: The Mirror 
Panel
	 The Mirror Panel allows you to dupli-
cate a selection in Fireworks by creating a 
mirrored copy of it. It consists of four but-
tons which lets the user mirror a selected 
object above, to the right, below, or to 
the left of its original location.
	 Before opening the Mirror panel 
source file in Flash, you should first devel-
op some working Fireworks JavaScript 
that will perform the mirror action, there-
by avoiding any additional complications 
introduced by Flash. For this example, 
I presume that you have installed the 
Command Prompt extension and are 
using it to test the script. If you do not, 
you can write your script in Dreamweaver 
and run it by choosing Commands > Run 
Script from within Fireworks.

Creating the Code for the 
Panel
	 Instead of attempting to figure out 
how to code a mirror from scratch, let 
Fireworks do much of the hard work for 
you by manually mirroring an object 
yourself and then copying the code 
found in the History panel:
•	 Open a new Fireworks document.
•	 Create or import a small test object to 

mirror. If you create your own, try not 
to make it symmetrical or you might 
not be able to tell if you correctly mir-
rored it.

•	 Hold down the Alt key in Windows 
(Option key on the Mac) and then drag 
your test object to create a copy to the 
right of the original.

•	 With the copy selected, choose Modify 
> Transform > Flip horizontal to flip it.

•	 A mirror of the original object has now 
been created. To see how it happened 
in terms of Fireworks JavaScript, take 
the relevant code from the History 
panel.

•	 Open the History panel.
•	 Select the steps that involve mirroring 

your test object.

•	 Copy the steps using the Copy icon.
•	 Open the Command Prompt panel by 

selecting Window > Command Prompt.
•	 Paste the History steps from the Clipboard 

to the Command Prompt editor.

	 You now have the steps required to 
mirror your test object. To see if they 
work, delete your test object, reselect 
the original, and run the steps in the 
Command Prompt using the Execute but-
ton. If you copied the steps correctly, your 
mirrored object should return just as it 
was before you deleted it.

Adding Variability to the 
Code
	 There still remains a small problem 
with the script as it exists in this form. 
The problem is that the position of the 
copy is currently hard-coded—based 
on where you dragged the copy when 
using your test object. Ideally the mir-
ror script should work for any object of 
any size, and place the mirrored copy 
flush against the edge of the original. 
To make this happen, the script needs 
to be edited a little to take in account a 
dynamic offset based on the selection’s 
width.
	 Assuming that one object is 
selected, you can get the selection’s 
width using fw.selection[0].width where 
fw.selection[0] represents the first object 
in the current document’s selection. 
Moving the copy by a distance of the 
selection’s width will place it right next to 
the original.
	 With that in mind, edit the script so it 
looks like the following:

fw.getDocumentDOM().

moveSelectionBy({x:fw.selection[0].

width, y:0}, true, false);

fw.getDocumentDOM().

reflectSelection(true, false, “auto-

TrimImages transformAttributes”); 

	 That takes care of mirroring an object 
to the right, but this panel should also 
mirror it to the left, top, and bottom as 
well. Referencing the script above, you 
can make versions for each direction.

Left:

fw.getDocumentDOM().

moveSelectionBy({x:-fw.selection[0].

width, y:0}, true, false);

fw.getDocumentDOM().
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reflectSelection(true, false, “auto-

TrimImages transformAttributes”); 

Top:

fw.getDocumentDOM().

moveSelectionBy({x:0, y:-

fw.selection[0].height}, true, false);

fw.getDocumentDOM().

reflectSelection(false, true, “auto-

TrimImages transformAttributes”); 

Bottom:

fw.getDocumentDOM().

moveSelectionBy({x:0, y:

fw.selection[0].height}, true, false);

fw.getDocumentDOM().

reflectSelection(false, true, “auto-

TrimImages transformAttributes”);

	 After making sure the scripts work, 
save them and move on to Flash:
•	 Open Mirror Template in Flash. It 

should consist of the interface used 
for the Mirror panel. You can find it at 

Source Files/Templates/Mirror.fla.
•	 Invoke the publish settings by choos-

ing File > Publish Settings.
•	 In the Formats tab, select Flash as 

the only format and set the publish 
destination to be your Configuration/
Command Panels folder in your 
Fireworks installation folder.

•	 Publish your SWF.
•	 Restart Fireworks.

	 You have now established the Mirror 
panel in the Fireworks interface. You 
should be able to open it in Fireworks 
using Window > Mirror. It won’t do any-
thing at this point, but you at least have 
your foot in the door. To test your updates 
to the panel, simply close and reopen the 
panel window. The SWF will be updated 
with the last SWF you published.

Adding ActionScript to 
the Code
	 With all the groundwork set and the 
panel interface complete, you can start 
adding ActionScript. Like the Create Ellipse 
example earlier, the ActionScript for the 
Mirror panel is pretty basic. You’re only 
dealing with button actions and using 
MMExecute to send Fireworks JavaScript 
commands to Fireworks within them.
	 Given that there are four buttons, it 
would be best if the ActionScript was added 
to the Timeline (as opposed to directly on 
the buttons—something I did for the Create 
Ellipse panel for the sake of simplicity and 
convenience). In each button’s onRelease 
event handler, you can use MMExecute to 
relay the Fireworks JavaScript commands to 

Fireworks. With the current scripts, however, 
you’re now dealing with two lines of code 
instead of the one seen in Create Ellipse. 
That’s no problem. Each line can go in its 
own MMExecute function.
•	 In Flash, select the ActionScript frame 

on the main Timeline.
•	 Add the following script defining onRe-

lease event handlers to each button: 
Notice that a single quote ( ‘ ) was used 
to define the Fireworks JavaScript string 
sent into MMExecute. This is to prevent 
conflicts with the double quotes ( “ ) 
used in reflectSelection for “autoTrimIm-
ages transformAttributes”. You could 
have also escaped the double quotes 
within the script using \”. Using single 
quotes is often easier, however.

right_btn.onRelease = function(){

MMExecute(‘fw.getDocumentDOM().

moveSelectionBy({x:fw.selection[0].

width, y:0}, true, false);’);

MMExecute(‘fw.getDocumentDOM().

reflectSelection(true, false, “auto-

TrimImages transformAttributes”);’);

}

left_btn.onRelease = function(){

MMExecute(‘fw.getDocumentDOM().

moveSelectionBy({x:-fw.selection[0].

width, y:0}, true, false);’);

MMExecute(‘fw.getDocumentDOM().

reflectSelection(true, false, “auto-

TrimImages transformAttributes”);’);

}

top_btn.onRelease = function(){

MMExecute(‘fw.getDocument-

DOM().moveSelectionBy({x:0, y:-

fw.selection[0].height}, true, 

false);’);

MMExecute(‘fw.getDocumentDOM().

reflectSelection(false, true, “auto-

TrimImages transformAttributes”);’);

}

bottom_btn.onRelease = function(){

MMExecute(‘fw.getDocument-

DOM().moveSelectionBy({x:0, y:

fw.selection[0].height}, true, 

false);’);

MMExecute(‘fw.getDocumentDOM().

reflectSelection(false, true, “auto-

TrimImages transformAttributes”);’);

}

•	 Publish the SWF.
•	 Close and reopen the Mirror panel in 

Fireworks.
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•	 Test it.

	 With any luck, you should have a fully 
functional Mirror panel in Fireworks.

Debugging the Mirror Panel
	 Though functionally the panel 
works fine, you may notice a small flaw 
if you pay close attention to it. Watch 
the History panel as you use the Mirror 
panel; you will see that each time an 
object is mirrored, two history steps are 
created instead of one. This is because 
MMExecute is used twice each time a 
button in the Mirror panel is clicked. To 
keep History steps as condensed as pos-
sible, it would be best to reduce this to 
one.
	 This new script combines each set of 
MMExecute commands into one. Replace 
it in Flash, republish, and retest:

right_btn.onRelease = function(){

	var command = ‘fw.getDocumentDOM().

moveSelectionBy({x:fw.selection[0].

width, y:0}, true, false);’

	+ ‘fw.getDocumentDOM().

reflectSelection(true, false, “auto-

TrimImages transformAttributes”);’;

	MMExecute(command);

}

left_btn.onRelease = function(){

	var command = ‘fw.getDocumentDOM().

moveSelectionBy({x:-fw.selection[0].

width, y:0}, true, false);’

	+ ‘fw.getDocumentDOM().

reflectSelection(true, false, “auto-

TrimImages transformAttributes”);’;

	MMExecute(command);

}

top_btn.onRelease = function(){

	var command = ‘fw.getDocument-

DOM().moveSelectionBy({x:0, y:-

fw.selection[0].height}, true, 

false);’

	+ ‘fw.getDocumentDOM().

reflectSelection(false, true, “auto-

TrimImages transformAttributes”);’;

	MMExecute(command);

}

bottom_btn.onRelease = function(){

	var command = ‘fw.getDocument-

DOM().moveSelectionBy({x:0, y:

fw.selection[0].height}, true, 

false);’

	+ ‘fw.getDocumentDOM().

reflectSelection(false, true, “auto-

TrimImages transformAttributes”);’;

	MMExecute(command);

}

	 Now using the Mirror panel should 
result in only one History step.
	 With everything complete and work-
ing properly, there is one more concern 
that you may want to address: code reuse. 
Mirroring an object in Fireworks is a poten-
tially useful action. If you should ever want 
to perform this action again, it would be 
helpful to have an easily reusable snippet 
of code that would let you do so. At this 
point, the code is pretty divided, having 
different implementations between four 
different buttons. Using a single func-
tion to represent a mirror in any direction 
would be useful and reusable. Such a func-
tion may look like the following:

function mirror(horiz, vert){

	var dom = fw.getDocumentDOM();

	dom.moveSelectionBy({x:horiz*fw.selec-

tion[0].width, y:vert*fw.selection[0].

height}, true, false);

	dom.reflectSelection(Boolean(horiz), 

Boolean(vert), “autoTrimImages trans-

formAttributes”);

}

	 Where horiz and vert represent direc-
tions of mirroring. Passing the value (–1, 0) to 
the mirror function mirrors to the left. Using 
(0, 1) mirrors to the bottom. Implemented in 
the Mirror panel, it looks like this:

var mirror = ‘function mirror(horiz, 

vert){‘

	+ ‘ var dom = fw.getDocumentDOM();’

	+ ‘ dom.moveSelectionBy({x:horiz*fw.

selection[0].width, y:vert*fw.selec-

tion[0].height}, true, false);’

	+ ‘ dom.reflectSelection(Boolean(ho

riz), Boolean(vert), “autoTrimImages 

transformAttributes”);’

	+ ‘}’;

right_btn.onRelease = function(){

	MMExecute(mirror);

	MMExecute(‘mirror(1, 0);’);

}

left_btn.onRelease = function(){

	MMExecute(mirror);

	MMExecute(‘mirror(-1, 0);’);

}

top_btn.onRelease = function(){

	MMExecute(mirror);

	MMExecute(‘mirror(0, -1);’);

}

bottom_btn.onRelease = function(){

	MMExecute(mirror);

	MMExecute(‘mirror(0, 1);’);

}

	 You may notice that this script is back 
to using MMExecute twice again. It won’t, 
however, create two steps in the History 
panel as the original version using two 
MMExecute commands for each mirror 
did. This is because Fireworks registers 
History steps from JavaScript commands 
only if there was some reaction made 
as a result of the executed command. 
Defining a function causes no such 
reaction so no History step is recorded. 
Actually, calling the function does cause 
the history to be recorded, so only the 
second call to MMExecute will result in a 
history step.

Where to Go from Here
	 The two panels I discussed in this 
tutorial provided very basic examples 
of custom panels in Fireworks. A lot of 
focus was directed towards workflow and 
debugging, helping you prepare for when 
you decide to develop more complicated 
panels.
	 In Creating Fireworks Panels – Part 2: 
Advanced Custom Panel Development, I 
cover a more complex example dealing 
with the advanced capabilities of custom 
panels in Fireworks. You will see how you 
can use the return result of MMExecute to 
dictate actions in Flash as well as learn how 
to create some more advanced interfaces 
for panels using some new features avail-
able in Studio 8. 

Part 2 to this article can be found at www.
macromedia.com/devnet.
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his tutorial illustrates how you 
can use Macromedia FreeHand 
MX to create preliminary sketches 

of your site’s navigation scheme. The site 
navigation scheme is a map that shows 
how your web pages relate to one anoth-
er. Specifically, it shows how users will 
travel through your site as they click links 
and interact with application interfaces. 
A site’s navigation scheme is normally 
reflected in the navigation bars that are 
used on web pages.
	 This tutorial is the first in a series of 
tutorials that shows you how to build 
a dynamic website from start to finish 
with Macromedia Studio MX 2004. The 
complete set of tutorials is available in 
the Exploring Studio MX manual (www.
macromedia.com/support/documenta-
tion/en/studio). It includes the following 
tutorials:
•	 Sketching a Site Navigation Scheme in 

FreeHand
•	 Creating a Table-based Page Layout in 

Dreamweaver
•	 Creating a Banner Graphic in Fireworks
•	 Building a Navigation Bar with 

Fireworks
•	 Building Rich Media with Fireworks 

and Flash
•	 Assembling and Editing Studio Assets
•	 Building a Database Search Feature

Planning the Site Navigation
	 After you determine your site’s goals, 
target audience, and data requirements, 
you are ready to begin conceptualizing 
the site’s navigation scheme. In this 
tutorial, you’ll sketch the site navigation 
scheme for Trio Motors, a fictional compa-
ny that sells energy-efficient automobiles.
	 Trio Motors has requested an easy-

to-use navigation scheme that would 
allow their users to visit the company’s 
showroom, see previews of upcoming 
releases, view a page for Trio automobile 
owners, and find information about news, 
events, and financial services. Trio Motors 
would also like the site to focus on a fea-
tured technology, and to provide a search 
application that lets users search for a Trio 
Motors dealer in their area of the country.
	 As the web developer for the Trio 
Motors website, you decide on a simple 
navigation scheme that will consist of five 
links, all centralized on a home page. At 
the top of the home page, you’ll create 
a Macromedia Fireworks MX 2004 navi-
gation bar that links to separate pages 
called Showroom, News and Events, 
Owners, Financial Services, and Previews. 
Elsewhere on the page, you’ll create a link 
to a special page that provides current 
information about a featured technology. 
You’ll also create a link to a results page 
that displays the results of the search 
application.

Customizing FreeHand for 
Multimedia/Web Output
	 FreeHand MX is a print-friendly and 
web-friendly, vector-based drawing 
application. Before you begin sketching 
your site navigation, you’ll customize 
FreeHand for multimedia/web output. 
You’ll also use RGB or Web Safe Colors 
throughout the tutorial by selecting col-
ors from the Fill and Stroke Color pop-up 
menus. Web-safe color selection pop-up 
menus in FreeHand MX are identical to 
those in the other Macromedia Studio MX 
2004 tools.
•	 In FreeHand, create a new file by 

selecting File > New.

•	 At the bottom of the Document win-
dow, select Pixels from the Units pop-
up menu.

Note: The default unit of measurement for a 
new document is Points.

•	 In the Property inspector (Window > 
Document), click the Document tab.

•	 Select Web from the Page Size pop-up 
menu.

•	 This creates a page with a predefined 
size of 550 pixels by 400 pixels. You can 
also select Custom from the Page Size 
pop-up menu, and enter pixel dimen-
sions of your own.

•	 Select Edit > Preferences.
•	 The Preferences dialog box appears.
•	 Click the Colors tab and select None 

from the Color Management pop-up 
menu.

•	 Turning off Color Management allows 
you to view colors in a generic RGB 
environment.

•	 Click OK.
•	 (Optional) Select Fit Page from the 

Magnification pop-up menu in the 
lower left corner of the Document win-
dow.

•	 This option sets the magnification 
level so that the active page fits 
inside the Document window. You 
can also set magnification levels 
manually. The magnification with 
which you choose to work depends 
on your monitor size and your own 
preferences.

•	 Save the new document (File > Save) 
as trio_navigation.FH11.

	 If you are completing this tutorial as 
part of the Exploring Studio MX manual 
series, you can save the new file in the 

Sketching a Site 
Navigation Scheme 
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main directory of the Dreamweaver 
site you created in Chapter 6, “Setup for 
Sample ColdFusion Site.” It is good prac-
tice to keep all site-related files in the 
same location. For more information, see 
the Exploring Studio MX manual.

Creating Rectangles for the 
Navigation Scheme
	 After you customize your document 
for the web, you are ready to sketch the 
site navigation scheme in FreeHand.
•	 Make sure that the file you just created, 

trio_navigation.FH11, is open in the 
Document window.

•	 In the Tools panel, click the Rectangle 
tool and drag a rectangle on the page.

•	 When you release the mouse button, 
the new rectangle is selected. Leave 
the rectangle selected so that you can 
alter its properties.

•	 Note: This tutorial uses the example of 
a rectangle that is 135 pixels wide by 
52 pixels high. You can view and set 
the exact dimensions of a rectangle on 
the Object tab of the Property inspec-
tor (Window > Object).

•	 In the Tools panel, click the Fill color box 
and use the pop-up color palette to 
select a color for the inside of the rect-
angle. The example in this tutorial uses 
light blue (CCCCFF) for the rectangle’s fill.

•	 With the rectangle still selected, click 
the Stroke color box, and use the pop-
up color palette to select a color for 
the outline of the rectangle. The Stroke 
color box is above the Fill color box in 
the Tools panel. The example uses a 
darker blue (000033) for the rectangle’s 
stroke.

•	 Save your document (File > Save). 
Remember to save your work often as 
you make changes.

•	 In the Tools panel, click the Text tool 
and click once inside the rectangle.

•	 A text block appears inside the rect-
angle with a text ruler on top of it.

•	 On the Object tab of the Property 
inspector (Window > Object), do the 
following:

	 Select Arial from the Font pop-up 
menu.

	 Select Plain from the Style pop-up 
menu.

	 Select 18 from the Font Size pop-up 
menu.

	 Click the Align Center button
•	 In the Tools panel, click the Fill color 

box and select a fill color for the text. 
The example uses 000033, the same 
color as the outline of the rectangle.

•	 Type the word Home inside the rect-
angle.

•	 Click outside the text block to deselect 
it.

•	 Select both the rectangle and the 
text block by selecting Edit > Select > 
Select All.

•	 On the Align tab of the Align and 
Transform panel (Window > Align), 
select Align center from the Horizontal 
and Vertical pop-up menus, and click 
Apply.

•	 The text aligns vertically and horizon-
tally in the center of the rectangle.

•	 With the rectangle and text block still 
selected, select Modify > Group.

•	 The rectangle and text block become a 
grouped object.

•	 Select Edit > Clone.
•	 A duplicate copy of the grouped object 

appears on top of the original rect-
angle.

Note: The Clone feature is also available in 
Fireworks MX 2004.

•	 Drag the duplicate copy of the object 
below the original rectangle, as shown.

•	 Continue to clone and drag the 
original grouped object until you have 
eight objects on the page. Use the 
Pointer tool to arrange your rectangles 
as follows:

	 You can also use the arrow keys on 
your computer keyboard to position the 
rectangles more precisely. The arrow keys 
move objects up, down, left, or right, one 
pixel at a time.

Changing Rectangle Text
	 Next, you’ll change the text of your 
rectangles to describe the various pages 
of the website.
•	 In the Tools panel, click the Subselect 

tool.
•	 Click the word Home in the second 

rectangle (below the first rectangle on 
the page) to select the text block.

•	 In the Tools panel, click the Text tool.
•	 Select the text in the selected text 

block by holding down the mouse but-
ton as you drag over the word Home.

•	 Type the word Showroom.
•	 Click on a blank area of the document 

to deselect the text block.
•	 Repeat steps 1 through 6 for the 

remaining rectangles, using the fol-
lowing text: News and Events, Owners, 
Financial Services, Previews, Featured 
Technology, and Search.

•	 For longer text content, such as 
“Financial Services,” press Enter 
(Windows) or Return (Macintosh) after 
the first word and type the next word 
on the second line. Shift-click the text 
block and the rectangle using the 
Subselect tool. Then realign the text in 
the center of the rectangle by selecting 
Align center from the Horizontal and 
Vertical pop-up menus in the Align and 
Transform panel (Window > Align).

Adding Connector Lines to 
the Document
	 Now you’ll use the new Connector 
tool in FreeHand to add connector lines 
to the document. The connector lines 
show how the home page links to the 
individual files you specified.
•	 In the Tools panel, click the Connector 

tool.
•	 Move the pointer over the bottom line 
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of the Home rectangle.
•	 Hold down the mouse button and 

drag a connector line down to the 
top line of the Showroom rectangle. 
When you begin dragging, the Home 
rectangle becomes selected, indicat-
ing that there is an object from which 
a connector line can start. When you 
reach the Showroom rectangle, it also 
becomes selected, indicating that 
there is an object where the connector 
line can end.

•	 Release the mouse button.
•	 A connector line appears between the 

Home rectangle and the Showroom 
rectangle.

Note: If there isn’t enough space between 
rectangles to accommodate the default 
arrowheads of the connector line, the 
tool cannot draw the line properly. If you 
encounter this problem, try increasing the 
space between rectangles.

•	 Position the pointer near the starting 
point of the connector line you drew 
in the previous steps (the bottom line 
of the Home rectangle) and hold down 
the mouse button so that the Home 
rectangle is selected again.

•	 Drag another connector line to the top 
line of the News and Events rectangle. 
The Connector tool can be sensitive, 
so this may take some practice. Make 
sure that both rectangles are selected 
before you release the mouse button.

•	 Draw a third connector line from the 
bottom of the Home rectangle to the 
top of the Owners rectangle.

•	 Draw a fourth connector line from the 
bottom line of the Home rectangle to 
the top line of the Financial Services 
rectangle.

•	 Move the pointer over the handle at 
the center of the horizontal line you 
drew in step 8.

•	 The pointer changes to a resize pointer.
•	 Drag the horizontal line upward until 

it overlaps the other horizontal line on 
the page, as shown.

•	 Continue drawing connector lines until 
you have linked the Home rectangle 
to all the other rectangles on the page. 
Reshape connector lines as necessary 
by dragging the resize handles on the 
connector lines.

	 You now have a FreeHand document 
that shows the full navigation scheme. Your 
lines indicate that the Home page links to 
five separate pages called Showroom, News 
and Events, Owners, Financial Services, and 
Previews. It also links to a page about a fea-
tured technology, as well as to a page that 
provides the results of the search applica-
tion that you’ll build later.

Exporting the Plan as a 
SWF File
	 After sketching your site navigation, 
you can present the preliminary plan to 
your client or members of your group 
in a browser window. This is particu-
larly convenient if you want to share the 
document with people who do not have 
FreeHand.
•	 With your navigation scheme open in 

FreeHand, select File > Export.
•	 The Export Document dialog box 

(Windows) or Export dialog box 
(Macintosh) appears.

•	 Select Macromedia Flash (SWF) from 
the Save As Type pop-up menu 
(Windows) or Format pop-up menu 
(Macintosh).

•	 (Optional) If you want the file to 
open with Macromedia Flash Player 
immediately upon export, select 
Open in External Application, select 
Macromedia Flash Player from the 
External Application dialog box, and 
click Open.

•	 Click Save (Windows) or Export 
(Macintosh).

•	 The file is exported as a Flash SWF file 
to the location specified in the Export 
Document dialog box (Windows) or 
Export dialog box (Macintosh). If you 
selected Open in External Application, 
the plan opens in Macromedia Flash 
Player.

•	 You can now present the plan on any 
computer running a web browser 
and Flash Player. To view the plan in a 
browser window, drag the trio_naviga-
tion.swf file to an open browser such as 
Internet Explorer or Netscape Navigator. 
You can also present the plan with Flash 
Player alone by double-clicking the file.

Note: When you open the trio_navigation.
swf file in a browser, the plan is automati-
cally resized to fit in the browser window.

	 Completed versions of the files you 
created in this tutorial are available in 
the trio_motors_complete directory on 
the Studio MX 2004 CD. To locate the 
directory, insert your Studio MX 2004 CD, 
click Browse CD contents, and select the 
Samples folder. 
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ith the release of 
Macromedia ColdFusion 
7 and the arrival of Flash 

Forms, developers were presented with 
an alternative to HTML forms that offered 
them additional functionality, such as 
full-featured controls not available in 
HTML and built-in validation. That alone 
made Flash Forms appealing—and with 
the addition of pieces of ActionScript 
code, developers were able to create 
truly responsive forms. But because they 
were meant to be compatible with HTML 
forms, they still shared the same submit-
refresh model. What if you could “submit” 
the form and, without a page refresh, get 
feedback from the server?
	 Enter Flash Remoting. In this series of 
tutorials you will learn how to create an 
application that allows users to search 
and retrieve records from a database, and 
then edit, add, and remove them from 
the database—all in one screen. Those 
functions will be presented in the context 
of a sample application, a real state man-
agement system that administers listings 
of properties for sale.

Overview of the Real Estate 
Management System 
Sample Application
	 This article focuses on the search 
functionality of the sample application.
	 When you open the application, a 
small panel on the left lets users search 
for a property by specifying search cri-
teria, such as number of bedrooms or 
price range. The matching properties 
appear in a data grid in the upper right 
panel, and when a user selects a prop-
erty, the details appear in the lower 
right panel.

	 In the following sections you will do 
the following:
•	 Create the search form.
•	 Write a component to make the search 

query.
•	 Create a Flash Remoting service that 

handles the search request.
Call the Flash Remoting service and show 

the results in a datagrid.

Creating the Search Form
	 The whole application user interface 
is one Flash Form. As such, its contents 
are within the cfform tag:

<cfform format=”flash” 

name=”RealEstateAdmin”>

<!--- form content --->

</cfform>

	 The only necessary attribute of the 
cfform tag is the format=”flash” attribute 
to create a Flash Form. By assigning a 
name to the form, you will have a named 
scope that you can use later. You can also 
set the form’s dimensions by using the 
width and height attributes.
	 The Search panel contains several 
controls, all of them enclosed in a cfform-
group tag with a type attribute of “panel”:

<cfformgroup type=”panel” 

label=”Search” height=”440” >

<!--- controls --->

</cfformgroup>

	 These are the controls contained 
within the Search panel:
•	 The cfselect tags for Price range, 

Bedrooms, Bathrooms, and Minimum 
footage that create pop-up menus. You 
can populate cfselect tags from option 

tags, queries, or a combination of the 
two, as shown in this example:

<cfselect name=”search_priceRangeFrom”      

          query=”priceRange” 

          display=”label” 

          value=”data” 

          queryposition=”below”>

  <option value=”0”>No min.</option>

</cfselect>

•	 This cfselect tag uses a query called 
priceRange that contains two col-
umns—data and label—which popu-
late the search_priceRangeFrom select 
control. In addition, an extra option 
not present in the query (“No min.”) is 
manually added using an option tag. 
The name you give each control is 
important because you will later need 
to reference the control name when 
you submit the form.

•	 <cfinput type=”text”> tag for “MLS 
number”, as follows:

•	 <cfinput  name=”search_mls_id” 
type=”text” />

•	 <cfinput type=”radio”> tags for 
“Status.” You need one cfinput tag for 
each type of listing status (Active, Sold, 
Back Up Offers, New Listing). Option 
button tags that belong to the same 
group must have the same name. See 
the following:

<cfinput type=”radio” name=”search_

status” value=”active” 

label=”Active”/>

<cfinput type=”radio” name=”search_

status” value=”backUp” label=”Back Up 

Offers”/>

<cfinput type=”radio” name=”search_

status” value=”sold” label=”Sold”/>

The Real Estate 
Sample Application

Create an application that allows users to 
retrieve records from a database

by nahuel foronda & laura arguello

remoting

w

The sample files 

for this article can 

be downloaded at 

www.macromedia.

com/devnet/cold-

fusion/articles/

flashforms.html
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<cfinput type=”checkbox”> tags for 

“Amenities.” You need one tag for each 

type of amenity (Pool, Laundry, Walk-

in Closets, Fireplace). Unlike option 

buttons, each tag must have a differ-

ent name, as follows:

<cfinput type=”checkbox” name=”search_

hasPool”  label=”Pool”/>

<cfinput type=”checkbox” name=”search_

hasLaundry”  label=”Laundry”/>

<cfinput type=”checkbox” name=”search_

hasFireplace”  label=”Fireplace”/>

<cfformitem type=”text”> tags for 

additional labels or titles, as fol-

lows:

<cfformitem type=”text” 

style=”fontWeight:bold;”>Status:

</cfformitem>

<cfinput type=”button”> tag for the 

Search button:

<cfinput type=”button” name=”search_

submitBtn” value=”Search” />

	 You must also use additional cfform-
group tags to lay out the controls. Look at 
the index.cfm source file in the ZIP down-
load to see the complete code.
	 This small section of the application 
does not do anything yet. It only accepts 
user input of standard form controls: text 
inputs, option buttons, check boxes, and 
selects. At this point, you would normally 
add a Submit button to submit the form 
for processing on the server. But don’t do 
that yet—wait just a moment and com-
plete the following sections.

Coding the Search Query
	 As you may expect, you must write 
ColdFusion code to search the database. 
The sample files contain a ColdFusion com-
ponent (CFC), components/ListingGateway.
cfc, that queries the database but you could 
use a custom tag as well.
	 The search in this component has 
several arguments that correspond to 
the different search criteria: status, price, 
pool and other amenities, and so forth. 
The contains a simple query using the 
cfquery tag. All the arguments have a 
default value and the SQL statements will 
vary each time a user specifies a different 
combination of arguments. For instance, 
if the user doesn’t enter a status, the CFC 
ignores that criteria; therefore, the SQL 
statement will not contain that column in 
its WHERE clause. To exclude it, we used a 
simple cfif tag:

<cfcomponent name=”ListingGateway”>

<cffunction name=”search” 

access=”public” returntype=”query” 

output=”false”>

<cfargument name=”status” 

type=”string” default=”” />

 	<cfargument name=”priceFrom” 

type=”numeric” default=”0” />

	<cfargument name=”priceTo” 

type=”numeric” default=”0” />

 	<cfargument name=”hasPool” 

type=”boolean” default=”false” />

	<!--- additional arguments removed --

->	

			   

	<cfset var listingQuery = “” />

	

	<cfquery name=”listingQuery” 

datasource=”realestate”>

		 SELECT	*

		 FROM	listing

		 WHERE	

listing.price >= 

<cfqueryparam value=”#arguments.price-

From#” cfsqltype=”CF_SQL_MONEY”/>

<cfif arguments.priceTo GT 0>

		 AND listing.price <= 

<cfqueryparam value=”#arguments.pri-

ceTo#” cfsqltype=”CF_SQL_MONEY”/>

		 </cfif>

		 <cfif len(arguments.status)>

		 AND listing.status = 

<cfqueryparam value=”#arguments.sta-

tus#” cfsqltype=”CF_SQL_VARCHAR”/> 

		 </cfif>

		 <cfif arguments.hasPool>

		 AND listing.hasPool = <cfqueryparam 

value=”true” cfsqltype=”CF_SQL_BIT”>

		 </cfif>

<!--- additional sql removed --->	

		 ORDER BY price, listedOn

	</cfquery>

	<cfreturn listingQuery />

   </cffunction>

</cfcomponent>

	 When the query finishes processing, 
the CFC returns the results to the caller 
through the <cfreturn listingQuery /> tag.
	 So far, you should be familiar with 
the methods used. You created a form to 
request data from the user and wrapped 
a query in a CFC to retrieve data from a 
database. You may be wondering how 
to connect the form and the CFC. Read 
onward.

Creating the Flash 
Remoting Service
	 Flash Remoting is a Macromedia tech-
nology that lets Flash Player make asyn-
chronous calls to web services and receive 
responses back from the call. During 
these calls, it can send and receive sets 
of data. It consists of a gateway that sits 
on the server and some components that 
are included in the SWF file. Fortunately, 
ColdFusion 7 already contains the Flash 
Remoting gateway, so you don’t have to 
install any additional software. The SWF 
files generated by Flash Forms also contain 
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the Flash Remoting components because 
they are used internally.
	 Just as web services do, you must 
place Flash Remoting services in a web-
accessible directory. To create such a ser-
vice, you use a CFC, writing the functions 
that you want to provide to the service 
consumers. These functions must have 
their access attribute set to remote in 
order to be accessible to Flash consum-
ers.
	 Here is a simple example of a service:

<cfcomponent>

<cffunction 

name=”search” 

access=”remote” 

returntype=”query” 

output=”false” 

hint=”Returns listings matching the 

search criteria”>

	<cfargument name=”status” 

type=”string” default=””/>

<!--- code here that generates a query 

called myQuery --->

<cfreturn myQuery/>

</cffunction>

</cfcomponent>

	 We could have included the code that 
queries the database in the service CFC 
but it is better to separate presentation 

from data layers and keep well-defined 
tasks encapsulated in different compo-
nents. In this way, the core components 
that access the database can be com-
pletely separate from service components 
that may access them. The service compo-
nents, knowing that they are services, can 
offer additional functionality specifically 
targeted to Flash, such as formatting.
	 There is another advantage to this 
approach. It is common practice to keep 
components instantiated in a scope that 
spans several requests, such as the appli-
cation or session scopes. When a Flash 
Remoting call is made to a component, how-
ever, this component is instantiated at that 
time—and every time a request is made, a 
new instance of the component is created.
	 This means that Flash Remoting 
cannot call an already instantiated com-
ponent residing in memory in a shared 
scope. The only way to resolve this issue is 
to have a service component that differs 
from the component that does the actual 
work. When Flash Remoting calls a of the 
service component, this can reference 
the component residing in memory and 
make the appropriate invocations. For 
simplicity’s sake, this example instantiates 
ListingGateway.cfc but the source files use 
the memory-resident CFC approach.
	 Because the Search panel sends 
simple data types that match the types 
expected by the ListingGateway com-
ponent, the service can simply pass the 
same arguments along by using an argu-
mentCollection:

<cffunction name=”search” 

access=”remote” 

returnType=”query” 

output=”false” 

hint=”Returns listings matching the 

search criteria”>

<cfargument name=”status” 

type=”string” default=”” />

 	<cfargument name=”priceFrom” 

type=”numeric” default=”0” />

	<cfargument name=”priceTo” 

type=”numeric” default=”0” />

 	<cfargument name=”hasPool” 

type=”boolean” default=”false” />

	<!--- additional arguments removed --

->	

	

	<!--- you could also use cfinvoke or 

access a component in memory --->	

	

	<cfset var listingGateway = 

createObject(“component”,

“RealEstate.components.

ListingGateway”)/>	

	<cfreturn 

listingGateway.search(argumentCollecti

on=arguments) />

</cffunction>

Name this component ListingService.cfc 

and save it in the services folders.

Calling the Service
	 Now that you have created a ser-
vice, you are ready to call it. Provided 
that you are running ColdFusion on 
your local machine, the Flash Remoting 
gateway is typically located at http://
localhost/flashservices/gateway. That is 
its default address for ColdFusion instal-
lations.
	 Please note that this address might be 
different if you are using the built-in web 
server option (if your web root is located 
at http://localhost:8500).

Adding ActionScript to 
the Flash Form
	 To call a service from a Flash Form, 
you must write some ActionScript. You 
can add any piece of ActionScript code 
to the form by writing inline statements 
in the controls’ event handlers, such 
as onClick, or by writing code blocks 
in functions using the <cfformitem 
type=”script”> tag that has been added 
in the ColdFusion 7.01 Updater. For read-
ability and easier maintenance, we rec-
ommend using functions.
	 Because you will use this Flash 
Remoting service several times, we rec-
ommend that you store it in a variable 
that can be used by other functions and 
controls. Wrap the Flash Remoting setup 
code that creates the service and stores 
this variable in a called setUpRemoting():
<cfformitem type=”script”>

 setUpRemoting():Void{

	

}

</cfformitem>

	 Inside the cfformitem tag, declare the 
connection and service proxy as local 
variables:

//note the gateway address

var connection:mx.remoting.Connection 
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= 

mx.remoting.NetServices.createGatewayC

onnection(“http://localhost/flashser-

vices/gateway/”);

var myService:mx.remoting.

NetServiceProxy;

Declare an object that handles all the 

responses:

var responseHandler:Object = {};

	 This object must implement the 
necessary functions that will be auto-
matically called when the server sends a 
response from a CFC. The default func-
tions called on this object are onResult 
and onStatus. The server calls onResult 
when the service sends a successful 
response and calls onStatus when the 
service throws an error, when or some 
other type of error occurs. That means 
that the responseHandler object must 
have those two functions if it is expected 
to act upon service responses:

responseHandler.onResult = ( results: 

Object ):Void {

	//handle service response

}

responseHandler.onStatus= (status: 

Object ):Void {

	//handle error

}

	 Once the responseHandler objects 
knows how to behave, the actual service 
can be instantiated and stored in a global 
variable (RealEstateAdmin.myGlobalOb-
jects), as follows:

RealEstateAdmin.myGlobalObjects.

listingService = connection.

getService(“RealEstate.services.

ListingService”, responseHandler );

	 The getService() method of the connec-
tion class takes two parameters; the first is the 
path to the service. To get the path to your 
service, find the directory structure from your 
web root to your CFC, replace the slashes with 
dots, and remove the CFC extension.
	 For instance, if you saved the sample 
files in a folder called RealEstate in your 
web root and saved ListingManager.cfc in 
a folder called services, the path would be 
/RealEstate/services/ListingManager.cfc from 
a browser. Translating that to dot notation 
becomes RealEstate.services.ListingManager.
	 The second parameter is the object 
that handles the responses, which is the 
object you just created: responseHandler. 
Note that the service is not actually creat-
ed until you call a method on the service. 
So if you enter an incorrect path, you will 
not know it until you try to call it.
	 Now you have a that sets up a Flash 
Remoting service, but if you never call this 
, the service will never be set up. You can 
use the onload attribute of the cfform tag, 
which was introduced with the ColdFusion 
7.01 Updater to call the , as follows:

<cfform name=”RealEstateAdmin” 

format=”flash” onload=” setUpRemot-

ing()”>

	 That is not enough, however, because 
the service is stored in a global variable 
that you must also declare as the form 
loads. You can create yet another to be 
called as the form loads that sets up this 
global variable and possibly other set-
tings. While you are at it, call the setUpRe-
moting() right after that, as follows:

<cfform name=”RealEstateAdmin” 

format=”flash” 

onload=”formOnLoad();”>

<cfformitem type=”script”>

 formOnLoad():Void{

	//declare global variable

RealEstateAdmin.myGlobalObjects = {};

//call set up 

setUpRemoting();

	//set other properties as needed

}

//rest of the code

	 Assigning the Flash Remoting service 
to a global variable is only a suggestion. 
The most important code is what’s inside 
the setUpRemoting() .
	 Finally, you are ready to call the ser-
vice. Your Search panel readily accepts 
user input, you have set up the Flash 
Remoting service, and your CFC is eagerly 
waiting to be called. Remember how the 
Search panel had a Search button? Now 
you can make it functional by adding 
some actions to its onClick attribute:

<cfinput type=”button” 

name=”searchSubmit” value=”Search” 

onclick=”submitSearch()” />

But wait a minute. What is the submit-

Search() ? Because it is not a built-

in , you’re going to create it next.

Creating the submitSearch()

Within the same <cfformitem 

type=”script”> tag, add the new :

 submitSearch():Void{

	 The purpose of the submitSearch() 
is to gather all the information entered 
in the Search panel and send it to the 
ListingManager service.
	 If you recall, the CFC has several 
arguments. When making the call, you 
could send each argument, in order, as 
parameters to the call. But that becomes 
error-prone if the has many arguments. 
An easy way to send several parameters is 
to use a structure with keys that have the 
same name as the arguments.
	 To create a structure, you instantiate 
an empty object (or structure) that will be 
the container for all the data entered in the 
Search panel form fields. Then, one by one, 
take the data entered in each field and assign 
it to a key in the empty object, as follows:
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//get all the search criteria items

var searchArguments = {};

	

//in order to get data contained in 

Text inputs, 

//use myTextInputName.text

searchArguments.mls_id = search_mls_

id.text;

//to get data from radio buttons, 

//use myRadioButtonName.selectedData

searchArguments.status = search_sta-

tus.selectedData;

	

//checkboxes store their true/false 

value in their selected property, 

//myCheckboxName.selected

searchArguments.hasPool = search_

hasPool.selected;

searchArguments.hasWalkInClosets = 

search_hasWalkInClosets.selected;

searchArguments.hasLaundry = search_

hasLaundry.selected;

searchArguments.hasFireplace = search_

hasFireplace.selected;

	

//to get the selected choice in a 

dropdown, 

//use mySelectName.value or mySelect-

Name.selectedItem.data

searchArguments.footage = search_foot-

age.value;

searchArguments.bedrooms = search_bed-

rooms.value;

searchArguments.bathrooms = search_

bathrooms. value;

searchArguments.priceFrom = search_

priceRangeFrom.value;

searchArguments.priceTo = search_

priceRangeTo.value;

	 Once you have gathered all the nec-
essary data for the structure, you can 
make the call to your CFC, sending all the 
parameters as one structure. Recall that 
“search” was the name of the service in 
the ListingManager CFC:

RealEstateAdmin.myGlobalObjects.list-

ingService.search(searchArgs);

	 After you call the service and the 
matching records are retrieved, the server 
will send a query back with the results, 
even if it is an empty query. The respon-
seHandler object handles the response 
in its onResult , but if you go back to the 
“Calling the Service” section, you will see 

that the was empty, which doesn’t help 
much—when the results are returned, 
they will just be ignored.

Adding a Grid for the 
Results
	 The sample application shows the 
search results in a datagrid next to the 
Search panel. To implement this function-
ality, add a grid using cfgrid and name it 
listingGrid:

<cfgrid name=”listingGrid”  

rowheaders=”false”>

	<cfgridcolumn name=”price” 

header=”Price” />

	<cfgridcolumn name=”bedrooms” 

header=”Bedrooms” />

	<cfgridcolumn name=”bathrooms” 

header=”Bathrooms” />

	<cfgridcolumn name=”footage” 

header=”Footage” />

	<cfgridcolumn name=”type” 

header=”Type” />

</cfgrid>

	 Notice that the headers of visible col-
umns are properly named and the name 
attribute of each cfgridcolumn tag cor-
responds to a query column name.
	 Now that you have a control, assign 
the results to the grid’s data provider:

var listingGrid = listingGrid;

responseHandler.onResult  = (results: 

Object):Void {

	listingGrid.dataProvider = results;

}

Because the CFC might throw an error, 

you should also complete the onStatus 

to handle error responses:

responseHandler.onStatus  = ( stat: 

Object ):Void {

	alert(“Error: “ + stat.description);

}

Dealing with Asynchronous 
Processes
	 If the service returns a query, you 
might be wondering why you can’t sim-
ply use the following code:

//wrong code

listingGrid.dataProvider = listingSer-

vice.search(searchArgs);

	 The above code is not correct because 
the call to search is done asynchronously. As 

soon as the call is triggered, it does not wait 
for the server’s response; it continues run-
ning code written below it. For this reason, 
you must create an object (called respon-
seHanldler here) with functions that will be 
called when the server sends a response.
	 Another point to consider is that any 
communication across a network is unreli-
able. If the returned dataset is large, it 
might take some time to load. When using 
the page refresh model, the browser takes 
care of adding a progress bar to indicate 
that the next page is loading. Although this 
is not perfect, it does offer some feedback 
to the user. Now that your application does 
not use a page refresh model, how do you 
indicate to users that their request is being 
processed and they have to wait?
	 There are several approaches to this. 
A simple method is to show the default 
clock cursor that Flash Forms use when 
they load data. This is a simple solution 
that is consistent with the other functions 
of Flash Forms. To add that functionality, 
insert the following snippet before making 
the call to the remote service in index.cfm:

mx.managers.CursorManager.showBusyCur-

sor();

When the results come back, remove the 

cursor:

mx.managers.CursorManager.removeBusy-

Cursor();

	 Add this snippet to both the onResult 
and onStatus functions because you don’t 
know which one will get called. 

Part 2 to this article can be found at www.
macromedia.com/devnet.
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uring the course of read-
ing this article and carrying 
out the various exercises, 

you and your 3D artist colleagues will 
get a practical, hands-on idea of the 
workflow required to create and export 
Shockwave 3D content using any of 
the major 3D applications. You will 
create a 3D environment, export it as 
Shockwave 3D, and drive around it in 
a virtual vehicle using the keyboard’s 
arrow keys.
	 You are not required to use 
Macromedia Director. However, I do 
hope that after you get an idea of the 
power of the real-3D features of Director, 
you or your programming colleagues 
will be encouraged to download the trial 
version of Director and start working on 
some new and exciting Shockwave 3D 
content.
	 It will take approximately 30 minutes 
to finish the exercises presented in this 
article.

Applications for Shockwave 
3D Export
	 Make sure you have one of these 
supported applications installed. These 
applications all support Shockwave 3D 
export. The CanDo 3D Modeling Training 
Tool linked to above contains a sample 
3D scene for each of these packages:
•	 3ds Max
•	 Maya
•	 LightWave 3D
•	 trueSpace (GameSpace)
•	 Cinema 4D
•	 form·Z
•	 Eovia Carrara
•	 SoftImage|XSI
•	 3D Canvas Pro

•	 EIAS (Electric Image Animation System)
	 The downloaded training applica-
tion directly supports the Shockwave 3D 
export of all of these applications.

Why Create Shockwave 
3D Content?
	 Shockwave 3D is extremely powerful 
and flexible technology. While there are 
a number of different technologies that 
allow for interactive 3D content to be 
deployed over the Internet—and they 
all support the same basic functionality 
required for many applications, such as 
displaying interactive products—only 
a few allow for more advanced applica-
tions, such as an interactive game, to be 
implemented.
	 As with any rich online media, the 
popularity and installed base of the plug-
in is a very important factor. Since 1999, 
the Shockwave plug-in has incorporated 
interactive 3D technology (developed by 
some of Intel’s top software engineers) 
as part of its standard installation. This 
has ensured that approximately two 
out of three computers connected to 
the Internet already have Shockwave 
installed on them.
	 Shockwave 3D supports many 
features, such as reflection mapping, 
multitexturing, particle systems, subdi-
visional surfaces, toon rendering, and 
progressive level of detail. Skinning and 
bones can be exported from certain 3D 
applications.
	 A key feature of Shockwave technol-
ogy is that it allows for the integration 
of all forms of media, including the use 
of 3D content and 2D content (images, 
video, Flash, and so on) within the same 
interface. Some 3D-only solutions can be 

quite restrictive in allowing developers to 
implement a user interface to their con-
tent.
	 Shockwave 3D currently does not 
support advanced features such as pixel 
and vertex shaders. These are available 
only on newer computer systems and 
are therefore not viewable on many 
computers. However, this is more than 
made up for by ensuring that content 
can be viewed on every single comput-
er running Windows or Mac OS, regard-
less of whether or not an OpenGL or 
Direct 3D graphics card is even avail-
able (thanks to a built-in software ren-
derer).
	 A recent update to the Shockwave 
plug-in has slimmed the size of the 
installater from over 4 MB to a very com-
pact 2.5 MB. This makes it even more 
appealing to many computer users who 
want to view interactive content online 
and who still have dial-up modem con-
nections.

Creating a Shockwave 3D 
Scene from Scratch
	 The application you downloaded with 
this article allows you to export your 3D 
scene into an interactive Shockwave 3D 
environment using a very simple export 
process. For many of the applications, this 
will be as straightforward as exporting a 
single file.
	 The process goes something like this:
•	 Create or load your 3D scene.
•	 Ensure that a model exists, called 

carStart.
•	 Note: This is the only requirement of 

the application. The model is used to 
position and size the vehicle within the 
scene.

Creating a Shockwave 
3D Game Level in 30 Minutes

Export Shockwave 3D content using 
any of the major 3D applications

by mal duffin
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•	 Export the scene as Shockwave 3D 
(overwrite the gamelevel.w3d scene).

•	 Run the application.

	 That’s it! In most cases, the export 
process takes a matter of seconds. This 
allows 3D artists to try out a number of 
different ideas in a very short period of 
time.
	 To create a basic scene, follow these 
steps:
•	 Open your 3D application, create a box 

in the middle of the ground object, 
and call it carStart. The size of the box 
determines the size of the resulting 
vehicle within the Shockwave 3D envi-
ronment.

•	 Create a ground area for the vehicle 
to start on. This can be as simple 
as a plane object, or as a textured 
object—for example, with a tiled 
grass texture.

•	 Export the scene as Shockwave 3D 
and save it over the gamelevel.w3d 
file.

•	 Note: If you read the Instructions.doc 
file contained in the sample files down-
load, you’ll see detailed instructions on 
how to export Shockwave 3D content 
from the various different 3D applica-
tions.

•	 Run the application. For Windows, run 
the file “Play Car Game Level.exe”; Mac 
users currently have to run index.htm.

	 You will now be able to drive the 
vehicle around the ground object, using 
the keyboard’s arrow keys. In the next 
section, you will add new models to the 
scene.

Adding Models to the Scene
	 You are now going to add some 
objects to the environment:
•	 Add a second ground area with a con-

crete type texture applied to it.
•	 Add a jump ramp to allow access to 

the second ground area. In order to do 
this, first create a box.

•	 Drag two of the vertices of the box 
down to form a ramp.

•	 Apply different materials to the top 
and side of the ramp.

•	 Admire your new ramp.
	 Feel free to create and place addi-
tional models in the scene. In the next 
section, you will add some interactive ele-
ments to the scene.

Adding Interactive Elements 
to the Scene
	 You are now going to add some 
interactive elements to the scene. 
Place special characters in the name 
of the object within the 3D modeling 
application to allow interactions to be 
built up.
	 You can find more information on the 
various tags in the included Instructions.
doc file included in the sample files 

download linked to at the beginning of 
the article.
	 I’ve added a water texture to a plane 
under the ground objects, and I’ve named 
this object gameLose. As soon as the 
vehicle touches this water model, the 
game ends. There is a gameWin box at the 
far side of the wall. As soon as the car con-
nects with this object, the game is won.
	 In order to get to the gameWin box, 
however, the player must trigger off the 
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wall, called triggerOffExit, in the middle of 
the platform. This occurs when the player col-
lects the two pickups, called pickupExit01 and 
pickupExit02.
	 I have replaced the wall with a box with a 
tiled brick texture, and replaced the pickupExit 
objects with coins (cylinders).
	 In the next section, I will review changing 
the non-3D elements of the scene.
	 There are a number of external texture 
files, used by the game, that you can edit to 
help change the look and feel of the game. 
This helps to incorporate your Photoshop or 
Fireworks skills easily into the project.
	 Here are some of the main files, along with 
how they are used:
•	 vanlogo.jpg: Alters the logo on the back 

of the vehicle. The color of the very first 
(top left) pixel is used as the color of the 
rest of the vehicle. You can change the 
images on the sides and front of the vehi-
cle by creating the images vanlogoside.
jpg, vanlogosideb.jpg, and vanlogofront.
jpg.

•	 title.jpg: Appears right at the start of the 
game. You can create gamewin.jpg and 
gamelose.jpg, which will appear when 
those various events appear. These can 
also be replaced with Flash SWF files. See 
Instructions.doc for more information.

•	 logo.png: Appears over the top of the 
main 3D game window. By using trans-
parency within the PNG, you can overlay 
logos and instructions.

•	 speedometer.png: Displays the speedometer 
(position it with gamelevel.xml).

•	 steering.png: Shows the graphic for the 
steering wheel (position it with gamelevel.
xml).

	 You can also alter the music and sound 
effects (all of these are optional):
•	 music.mp3: Plays and loops at the title 

sequence, and in-game.
•	 voice.mp3: Plays once in-game before the 

music plays and can be used to give vocal 
instructions.

•	 titlemusic.mp3: Overrides the music played 
at the title screen.

•	 titlevoice.mp3: Plays once at the title screen 
before the title music plays.

•	 pickup.mp3: Overrides the sound effect for 
collecting a pickup item.

•	 pickupsfound.mp3: Plays when all of the 
pickups in the scene are collected.

•	 titlemusic.mp3: Overrides the music played 
at the title screen.

•	 gamewin.mp3, gamelose.mp3, gamewin-
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voice.mp3, gamelosevoice.mp3: Music 
and voice played at the game-win and 
game-lose screens.

	 Various elements of the game, 
such as the vehicle dynamics, can be 
altered using the gamelevel.xml file. See 
Instructions.doc for more information.
	 In the next section, you will export 
and load the sample scene.

Exporting and Loading 
the Sample Scene
	 When you download the applica-
tion, you’ll see a folder called “Sample 
3D Scene.” This contains a sample 
scene in the native format for all sup-
ported 3D applications. You can load 

this scene into your application and 
get a feel for how some of the interac-
tions can be set up. You’ll see some 
examples of other game-related fea-
tures, such as sky boxes and physical 
moving objects.
	 If you have an existing 3D scene that 
you would like to drive around, simply 
follow these steps:
•	 Load your 3D scene.
•	 Create a new object (for example, a 

box) in the scene:
	 Position it over some sort of ground 

model.
	 Scale it to about the size of the 

required vehicle.
•	 Name this object carStart.
•	 Export the level, like before, as game-

level.w3d.
•	 Run the executable file.

	 You should now be able to drive 
around your 3D scene.

Some Advanced Techniques
	 Consider undertaking these special 
projects to become more familiar with 
what I’ve covered in this article.

Creating a Sky Box
	 A sky box is a special game-related tech-
nique used to surround an environment with 
six prerendered images, mapped on to each 
side of a box object. By naming the object 
skybox, the game will automatically process 
the object and use it in the correct way.

Creating Physical, Movable 
Objects
	 When you create an object in 
the level, such as a crate or barrel, 
you can easily turn it into a movable 
object within the Havok physics sys-
tem. To do this, place the tag moving 
before the object’s name. The next 
time you export the scene, you will 
be able to collide with the object and 
it will behave in a physically correct 
manner.
	 You can discover more advanced 
techniques by reading Instructions.
doc and Advanced Instructions.doc 
contained within the sample download 
file.

Viewing Existing Levels
	 You can see existing levels created 
using the training application in the 
CanDo Interactive Showcase (www.can-
dointeractive.com/gamedesign/car/lev-
els).

Where to Go from Here
	 You now have experience creat-
ing and exporting Shockwave 3D 
content. You have seen how easy it is 
to export your environment, and you 
have an idea of the type of models 
that are suitable for use within that 
environment. Hopefully you have been 
inspired to create more Shockwave 
3D content using the latest version of 
Director. 
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